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1. Learning GMS

What is GMS?

The Groundwater Modeling System
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GMS system consists of a graphical s |13
B8
user interface (the GMS program) and .
@
a number of analysis codes L
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(MODFLOW, MT3DMS, etc.). The
GMS interface is developed by
Aquaveo, LLC in Provo, Utah.

GMS was designed as a

comprehensive modeling environment. AT O oz

Several types of models are supported .
SUB package vertical displacement plot.

and facilities are provided to share
information between different models

and data types. Tools are provided for ST
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site characterization, model
conceptualization, mesh and grid
generation, geostatistics, and

post-processing.

Modules

The interface for GMS is divided into

eleven modules. A module is provided

for each of the basic data types
supported by GMS. As you switch B —
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from one module to another module,
the Dynamic Tool Palette and the Solid cross sections and boreholes.

Menus change. This allows you to

focus only on the tools and commands related to the data type you wish to use in the modeling process. Switching
from one module to another can be done instantaneously to facilitate the simultaneous use of several data types when

necessary. The following modules are supported in GMS:

&5 TIN Module
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@ Borehole Module

&3 Solid Module

% 2D Mesh Module

B 2D Grid Module

2D Scatter Point Module
& 3D Mesh Module

g 3D Grid Module

&g 3D Scatter Point Module
- Map Module
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Isosurface on a 3D grid and borehole sample data.

@ GIS Module
& UGrid Module

Numerical Models

Numerical models are programs that are separate from GMS that are used to run an analysis on a model. The models
can be built in GMS, and then run through the numerical model program. GMS can then read in and display the

results of the analysis.

With most numerical models, GMS has the option of using a Model Wrapper to run the model and display real-time

results during the model simulation.

The following numerical models are currently supported in GMS.

Model Name GMS Module

¢ MODFLOW 3D Grid
« MODPATH

¢ MT3DMS

¢ RT3D

¢ ART3D

¢ SEAM3D

« UTCHEM

e PEST

« SEAWAT (starting v8.0)

+ MODAEM Map Module
« UTEXAS

* SEEP2D 2D Mesh

« FEMWATER 3D Mesh

* T-PROGS Boreholes

(1]

Source code for most models is available upon request. Contact technical support * * to request source code.
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The GMS Screen

The GMS screen is divided into seven ——
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Modules

coordinates of selected items (vertices,
nodes, scatter points, etc.). The
coordinates are changed by typing in new values and hitting the ENTER or TAB key. The scalar data value (F:)

associated with the selected object can also be edited.
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Tool Palette

Several Tool Palettes can be displayed in the GMS interface. Default tool palettes include the Macros Palette, the
Static Tool Palette, the Dynamic Tool Palette, the Mini-Grid Plot Palette, and the Module Palette. (For more

information on each of these palettes see Tool Palettes)

Graphics Window

The primary graphical input and output for GMS takes place in the Graphics Window. The action taken when you

interact with the Graphics Window depends on which tool is selected.
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The GMS Screen

;
Attribute Table.
Redistribute Vertices...
Interp. Vertex Elevations
Reverse Arc Direction
Build Polygons

Arc(s) -> Cross Sections
Group

Select Intersecting Object.

Offset Arc...
Stitch Arcs

Delete

Example of a right-click menu on a arc in the

map module.

Project Explorer

Every object that can be selected in the
Graphics  Window now has a
corresponding right-click menu
available. These menus contain
commands that allow the user to
manipulate the data or display of the
selected items.

The Project Explorer is located at the left side of the GMS window by default, but it can be moved to anywhere on

the window since it is a dockable toolbar. The [Project Explorer contains a hierarchical representation of the data

associated with a modeling project. The Project Explorer can also be resized simply by clicking on the window

borders and dragging them to a new location.

Many commands on the data in GMS can be executed by right-clicks in the Project Explorer. For general commands

or to create new data objects you can right-click on the empty space in the Project Explorer and the following

pop-up menu is available. The visibility of items in the Graphics Window can also be controlled by selecting the

toggle next to each item in the Project Explorer.

See Datasets in the Project Explorer to learn about datasets in the Project Explorer.
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The GMS Screen

R . Time Step Window
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Example of the Project Explorer . . .
P The Status Bar is used to display the cursor coordinates, the IJK

indices of the cell beneath the cursor, the dataset value beneath the
cursor, data associated to selected items, and other information.

l
'g E @ ﬁ E ﬁ @@ ‘é’i ': ])(: 6139710 ¥: 3428355.0 Z:0.0 F: 213.97299194: ID: 1619 L24 k32 K:1

Cell ID: 1135; Material: material 1; Centroid x: 613894, y: 3.42857e+006, z: 200.45; Size i: 30.25, j: 86,3068, k: 47 8255
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Tool Palettes

Tool Palettes

There are several Tool Palettes that can be displayed in the GMS interface. Below are the tool palettes that are on by

default.

Macros

Many of the more frequently used
can be accessed
These

buttons essentially serve as shortcuts to

menu commands

through the macro buttons.

menu commands.

LEHgOwWFoEaQ e o il

Static Tool Palette

The Static Tool palette contains the
tools which are available in every
module. These tools are tools for basic
operations such as panning and
zooming. Only one tool is active at any
given time. The action that takes place
when the user clicks in the Graphics
Window depends on the current tool.
The following table describes the tools

in the Static Tool palette.

] File Edit Display Grid MODFLOW Window Help
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Project Explorer
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T*==Static Tool Palette

=g Dynamic Tool Palette
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Tool Tool Description
Name
-\&*ﬁ Pan The Pan tool is used to pan the viewing area of the Graphics Window. Panning can be done in 3 ways:

dragging with the mouse.

*  When the Pan tool is active, holding down the main mouse button while dragging moves the view.

e If your mouse has a middle button (or a mouse wheel), you can hold it down and drag to pan the view.

e If another tool is active and you don't want to switch tools, you can pan by holding down the F2 key and clicking and

(2 Zoom

the SHIFT key zooms out.

dragging with the mouse.

The viewing area can be magnified/shrunk using the Zoom tool. Zooming can be done in the following ways:

e If your mouse has a middle button (or a mouse wheel), you can scroll the wheel to zoom in and out.

e With the zoom tool selected, clicking on the screen zooms the display in around the point by a factor of two. Holding down

*  With the zoom tool selected, a rectangle can be dragged around a portion of the display to zoom in on that region. Holding

down the SHIFT key zooms out.

e If another tool is active and you don't want to switch tools, you can zoom by holding down the F3 key and clicking and
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4% | Rotate The Rotate tool provides a quick way to rotate the viewing location. Rotating can be done in the following ways:

¢ With the rotate tool selected, holding down the mouse button and dragging the cursor in the Graphics Window rotates the
object in the direction specified. A horizontal movement rotates the image about the z axis. A vertical movement rotates the

image about the x and y axis. The amount of rotation depends on the length the cursor moves while the mouse button is down.

» If another tool is active and you don't want to switch tools, you can rotate by holding down the F4 key and clicking and
dragging with the mouse.

¢ The viewing angle can also be entered directly.

+% | Measure | The Measure tool provides a quick way to measure distances.

* The tool is only available in plan view.

* Measuring is done by selecting the tool and clicking on the Graphics Window with the mouse. A single line or a polyline can
be created with a double-click used to end the line. The backspace key removes the last point clicked.

* The instantaneous and total lengths are given at the bottom of the GMS window. The length units correspond to those
selected in the Units dialog. A units conversion takes place if the current horizontal Projection units are different than those in
the Units dialog.} }

Dynamic Tool Palette

When the active module is changed by selecting an object in the Project Explorer, the tools in the Dynamic Tool

Palette change to the set of tools associated with the selected object/module. Each module has a separate set of tools.

Mini-Grid Plot

The Mini-Grid Plot appears when a 3D grid is in memory and is activated when the orthogonal viewing mode is
active. In the orthogonal mode, the viewing angle is always parallel to one of the three grid axes (I, J, or K) and only
one of the rows, columns, or layers is displayed at one time. The Mini-Grid Plot shows an idealized representation of
the 3D grid and shows which of the rows, columns, or layers is currently being displayed. The current row, column,

or layer can be changed using the arrows just below the Mini-Grid Plot.
Mini Grid: @ Lay tk3: [1 o]l

Mini-Grid Toolbar

The Mini-Grid Toolbar appears when a 3D grid is in memory and is activated when the orthogonal viewing mode is
active. In the orthogonal mode, the viewing angle is always parallel to one of the three grid axes (I, J, or K) and only
one of the rows, columns, or layers is displayed at one time. The Mini-Grid Toolbar shows an idealized
representation of the 3D grid and shows which of the rows, columns, or layers is currently being displayed. The

current row, column, or layer can be changed using the arrows just below the Mini-Grid Toolbar.

M cog: 5 [

Module Palette

The Module Palette is used to switch between modules. Only one module is active at any given time. However, the
data associated with a module (ex. a 3D finite element mesh) is preserved when the user switches to a different

module. Activating a module simply changes the set of available tools and menu commands.

lighELHNAaIB VO
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The Project Explorer is located at the left side of the GMS window by
default. It can be moved to anywhere on the window since it is a
"dockable" toolbar. The Project Explorer contains a hierarchical
representation of the data associated with a modeling project.
Previously only the data form the active module was displayed in the
Project Explorer, but now all of the data in GMS is always displayed
independent of the active module. The new Project Explorer can also
be resized by clicking on the window borders and dragging them to a

new location.

All of the modules have root items corresponding to them. Each root
item may be right-clicked on to accomplish certain actions. Data for
each module is grouped into folders. The modules and items can also
be expanded and colapsed to show sub folders. Each item may also be
turned on or off by clicking the check box next to the item. Many items
in the project explorer can be dragged to different locations to be used

with different modules. Items may also be duplicated.

Many commands on the data in GMS can be executed by right-click

menus in the Project Explorer. For general commands or to create new

data objects you can right-click on the empty space in the Project Explorer and the following pop-up menu is
available. Right-click commands can also be used to export or transform items. The visibility of items in the

Graphics Window can also be controlled by selecting the toggle next to each item in the Project Explorer.
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Tutorials

Tutorials

A rich set of step-by-step tutorials has been developed to aid in learning how to use GMS.

The tutorials are in PDF format. They are installed in the "docs" or "tutfiles" directory in the folder where GMS is
installed.

The tutorials are listed below by subject and are not necessarily listed in the suggested order of completion. Some
tutorials assume a basic knowledge of GMS and some build on other tutorials. When this is the case the tutorial itself
will state which tutorials you should complete beforehand.

Many of the tutorials have files that are needed to run the tutorial. These files can be found in the "tutfiles" folder
where GMS was installed.

Current GMS tutorials are posted at www.aquaveo.com/gms-learning [

Previous Versions

For previous versions of the GMS tutorials, click on one of the following links. For the current version, see the tables

below.

* GMS 6.5 Tutorials
¢ GMS 7.0 Tutorials
* GMS 7.1 Tutorials
¢ GMS 8.0 Tutorials
¢ GMS:Tutorial Tables 8.1 [2]
¢ GMS:Tutorial Tables 8.2 [3]
¢ GMS:Tutorial Tables 8.3 [4]

References

[1] http://www.aquaveo.com/gms-learning

[2] http://www.aquaveo.com/gms-81tutorials
[3] http://www.aquaveo.com/gms-82tutorials
[4] http://www.aquaveo.com/gms-83tutorials
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2. Set Up

64 bit

Starting at GMS 8.1, GMS is available in a 64 bit version. This means:

* GMS can access more RAM so larger models can be created
* A 64 bit version of MODFLOW is included and can be used by changing an option in the Preferences dialog
* ArcObjects is not available because ESRI [ has not created a 64 bit version

References

[1] http://www.esri.com

License Agreement

AQUAVEO SOFTWARE LICENSE AGREEMENT

We understand that neither Aquaveo LLC nor its employees makes any warranty express or implied, or assumes any
legal responsibility for the accuracy, completeness, or usefulness of the computer programs and documents herein
ordered. We acknowledge that Aquaveo’s liability for damages associated with these programs is limited to the
amounts paid to Aquaveo. We understand that we may register the executable on only one machine per license
purchased. We also agree to not make the program available to more persons, at any given time, than the number of
licenses purchased. We agree to not distribute this program in unmodified or modified form, outside our organization

without the written permission of Aquaveo.

License agreements for software used by Aquaveo software

FTGL LICENSE AGREEMENT

http://ftgl. wiki.sourceforge.net/states: "FTGL is free software. You may use it, modify it and redistribute it under
the terms of the MIT license or the GNU LGPL, at your option."

The MIT license link is to http://en.wikipedia.org/wiki/MIT_License, which states:

Copyright (c) <year> <copyright holders> Permission is hereby granted, free of charge, to any person obtaining a
copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction,
including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following

conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the

Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN
AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION



http://www.xmswiki.com/xms/index.php?title=GMS:Preferences
http://www.xmswiki.com/xms/index.php?title=ArcObjects
http://www.esri.com
http://www.esri.com
http://ftgl.wiki.sourceforge.net/
http://en.wikipedia.org/wiki/MIT_License,
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WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Registering GMS

When you first install GMS, it will be running in Demo Mode. All GMS functions will be enabled with the
exception of printing and saving. Anyone can run GMS in Demo Mode on any computer and it can be freely

distributed. To enable the print and save functions, you need either a password or a hardware lock.

The components (modules, interfaces) can be licensed individually depending on the needs and interests of the user.
The components of GMS are licensed using a password system. The Register command is used to enter a password
that enables the licensed components. This command can be used to enable the program after initially installing
GMS, or for adding additional modules to the program at a later time. The Register command must be used before

any files can be saved or printed. Before registration, GMS will run in Demo Mode.

When the Register command is selected, the Register dialog appears. The first item shown in the dialog is the
security string. This string is keyed to the hard drive of the computer where GMS is installed and uniquely identifies
the computer. When first registering GMS, this security string should be reported to the distributor or reseller where
GMS was purchased. The reseller then provides a password which should be entered in the edit field at the top of the
dialog. Once the password is entered, the Register button is selected. If the security string was reported correctly and
the password was entered correctly, the text next to each of the licensed components changes from "DISABLED" to
"ENABLED".

The Details button brings up a dialog listing the phonetic code for the security string. When reporting the security
string over the phone to get a password, using the phonetic code can be helpful in avoiding errors.

Once GMS has been registered, a file called gmspass.txt is created. Since GMS is licensed on a per/seat basis,

arrangement must be made to get an additional password if GMS is to be moved to another computer.

Also, GMS can also be enabled using a hardware lock, rather that a password. Contact your GMS reseller for details.

Password

From the File menu, select the Register command. This brings up the Register dialog, which has a "security string"
listed at the top. Send this security string along with your name, company, phone number, and e-mail address to your

vendor.

After verifying that you are a licensed user, a password will be sent to you. When you receive the password, enter it
in the Password field in the Register dialog and click the Register button. The modules you purchased will become

enabled and GMS will run in Normal mode.

Hardware Lock

Follow the instructions you received with the hardware lock to install the hardware lock and accompanying drivers.
If you did not receive hardware lock instructions, or they have been misplaced, they can be found in the
\Utils\Hwlock\Instructions directory on the CD. There are separate files for single user and network hardware locks.
These files can be read using your web browser. If you would like to purchase or have questions about hardware

locks, please contact your vendor.
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Community Edition

Starting at version 8.0 there is a free version of GMS called "Community Edition". It is limited to include only the
3D grid module and the MODFLOW model interface. It is also restricted in the size of the grid and the number of
MODFLOW stress periods. Any size model can be imported, but if the grid exceeds 5000 cells or the number of
stress periods is more than 3 the project cannot be saved and a watermark is displayed in the graphics window. The
community edition must still be registered using a license code which can be obtained via the internet from the

Registration Wizard (Help | Register | Change Registration | Get Community Edition License).

You can check if you are running in Community Edition mode by going to the Registration dialog. The size limits

are displayed in the About dialog which is accessed through the About command in the Help menu.

O Register GMS == Sl =
¥ Show only enabled modules i The GMS Community Edition license allows for a limited-sized grid and
Eeperals |Status | % MODFLOW simulation.
Community Edition | Enabled Maximum grid size: 5000 cells.
Maximum number of stress periods: 3.
Those limits have been exceeded: saving/exparting has been disabled.
Visit www.aquaveo,com to learn how to upgrade your license.
GMS Community Edition warning dialog.
Password
License expires 30 Nov 2011
= 6Ms - [untitied.gpr ) ===
Hardware lock:  Mane [ Fle Edit Display Gid MODFLOW Window Help =[x
License expires N/A NEHS I CFQ3ER 0 BNBEE|" x| ifMhpwmm
Maintenancs expires:  N/A @ =4
Change Registration x|t
%
Help.. Show Log.. i Close
[5] Zone Budcet 1Ds [i:]
R Gobal @
e
. . dial i . Eemm .
St e
GMS registration dialog showing IS
C@
. P @
[ER
that GMS is running in =ho
. . [ HaNt
Community Edition mode.
\\\\ =
s vz B o7

GMS showing watermark in Community Edition

when size limits are exceeded.



http://www.xmswiki.com/xms/index.php?title=GMS:3D_Grid_Module
http://www.xmswiki.com/xms/index.php?title=GMS:MODFLOW
http://www.xmswiki.com/xms/index.php?title=GMS:Importing_MODFLOW_Files
http://www.xmswiki.com/xms/index.php?title=GMS:Registering_GMS
http://www.xmswiki.com/xms/index.php?title=File%3ADlg_register_gms.png
http://www.xmswiki.com/xms/index.php?title=File%3ADlg_gms_ce_warning.png
http://www.xmswiki.com/xms/index.php?title=File%3AGms_ce_watermark.png
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Graphics Card Troubleshooting

XMS (WMS, GMS, or SMS) use OpenGL for rendering graphics. OpenGL is a graphics standard, but each
implementation is maintained by individual graphics card companies. Different graphics cards and drivers support
different versions of the OpenGL standard. XMS currently uses features up to version 1.5 of OpenGL (as of April

2009 version 3.1 was most recent version).

Some graphics cards, as well as remote desktop, do not support functionality through OpenGL version 1.5. This is
mostly a problem with older integrated graphics cards, in particular those manufactured by Intel. This page will give
you some ideas on troubleshooting these problems. The best solution is to get a graphics card that supports later

versions of OpenGL. You will see improved performance as well as be able to access all the features of XMS.

Remote Desktop
XMS (WMS, GMS, or SMS) will have reduced capability when running remote desktop.
Since remote desktop only supports OpenGL version 1.1 not all of the features of XMS may be available.

1. One solution is to use a different remote control software that utilizes the graphics card of the computer you are
controlling. www.logmein.com [ has free and paid versions of remote desktop that behave better with XMS.
Real VNC is a program that does this and can be purchased at a reasonable cost. There is a free version but it has
not been tested with the XMS software. See VNC Homepage 2] for more information.

2. Another solution is to use the Mesa software rendering option available in the application's graphic preferences.

See the section below on OpenGL Graphics Dialogs for discussion of this option.

Parallels Desktop for Mac

XMS has reduced capability when running in a pure virtual PC through Parallels Desktop for Mac. Although
Parallels version 6.0 provides OpenGL version 2.1 support (instead of OpenGL version 1.1) when "Enable 3D
acceleration" is selected in the virtual machine's hardware configuration, the Parallels virtual video card adapter does
not render all XMS graphics correctly. The solution is to use the Mesa software rendering option available in XMS's

graphic preferences. See the section below on OpenGL Graphics Dialogs for discussion of this option.

If you are running XMS in a virtual PC utilizing a Boot Camp partition then Parallels uses the actual graphics card

installed in the Mac. See sections below regarding graphics card issues.

OpenGL Graphics Dialogs

XMS (post WMS 8.2, GMS 7.0 onward, and SMS 10.1 onward) have dialogs that allow the selection of OpenGL
support. The choice is between the system default library and the Mesa software library. The system default can
change based upon current conditions such as a remote login. Not all system defaults support all needed graphics
functionality. Therefore Mesa is provided for better functionality at a potential reduction in speed. However, Mesa
may produce poor images when printing. The user can make this tradeoff in the graphics dialog found in preferences.

The dialog provides 4 options so that on subsequent runs XMS will:

1. Ask which graphics library to use if the system does not support all OpenGL functionality needed by XMS. This

option is initially set and gives the following options:

1. Autoselect the Mesa software library for this run if the system default does not support all functionality. XMS
will not prompt on subsequent runs. It will just check support and select a library.

2. Use the system default library on this run (and on future runs if the "Do not ask again box" is checked).

3. Use the Mesa software library on this run (and on future runs if the "Do not ask again box" is checked).

2. Autoselect the Mesa software library if the system default does not support all functionality.



http://www.logmein.com/
http://www.realvnc.com/
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3.
4.

Always use the system default library.

Always use the Mesa software library.

Determining Graphics Card Manufacturer

Always download and install the latest drivers from your graphics card vendor. Graphics card problems are often due

to using the wrong or outdated drivers. You can use a simple diagnostic program called dxdiag 31 to determine your

computer's hardware, operating system, and graphics card. To use the dxdiag 31 program:

1. Select Start
2. Choose Run.
3.
4
5

Type "dxdiag" in the box and click OK.'

. Click Yes to the prompt, and the program will begin running.

. Select the Display tab and the Name listed under the "Device" section is the name of your graphics card.

You can also:

1. Right-click on the desktop and select Properties

2. In the Display Properties dialog, click on the Settings tab

3.

4. Look for the names NVIDIA, ATI, Intel, Matrox, SiS, S3, etc.

Your video card manufacturer and chipset is shown below the "Display:" line

Updating Laptop Graphics Card Drivers

If you have a laptop, visit the laptop manufacturer's website (Dell [4], HP or Compaq [5], Toshiba [6], Sony [7], etc.)

to get the most recent driver.

Updating Desktop Graphics Card Drivers

If you are using a desktop computer, visit the graphics card manufacturer's website to download the latest driver.

Listed below are a few common graphics cards and links to download their drivers:

3DLabs !
ATI !
Diamond [10]

Elsa (1]
1121

[13]
[14]

Inte
Matrox
nVidia
3 151 Not all $3 card support OpenGL 1.5 which is required for all display options to be enabled.
SIS %1 _ Not all SIS card support OpenGL 1.5 which is required for all display options to be enabled.
VIA 17— Not all VIA card support OpenGL 1.5 which is required for all display options to be enabled.



http://en.wikipedia.org/wiki/DxDiag
http://en.wikipedia.org/wiki/DxDiag
http://www.dell.com/
http://welcome.hp.com/country/us/en/support.html
http://www.toshiba.com
http://www.sony.com
http://www.3dlabs.com/support/drivers/
http://ati.amd.com/support/driver.html
http://www.diamondmm.com/
http://www.elsa.com/supports/download.asp
http://support.intel.com/support/graphics
http://www.matrox.com/mga/support/drivers/latest/home.cfm
http://www.nvidia.com/content/drivers/drivers.asp
http://www.s3graphics.com/drivers.jsp
http://www.sis.com/support/support_prodid.htm
http://www.viaarena.com/default.aspx?PageID=2
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Updating Windows Operating System

Many problems are resolved by keeping the windows operating system and hardware drivers up to date using the

[

windows update site 18 Hardware updates are often only installed if the "Custom" or "Optional" updates are

included.

Updating XMS Software

Many problems are resolved by installing the latest version of XMS. Bugfixes and updates are released frequently.

The updates can be downloaded at the Aquaveo Download Center (191

Known Graphics Issues
* Issue: Graphic symbols are not displayed correctly and sometimes corrupt text lines located next to them.

Hardware: Make: ATI Technologies Inc. Model: RADEON X600 PRO (0x5B62) Name: ATI Radeon
X300/X550/X1050 Series

Solution: Updating the driver will allow the symbols to display correctly, but the text corruption still remains.

Switch from Hardware to Software Rendering

THE FOLLOWING SHOULD BE ATTEMPTED ONLY IF THE OTHER SOLUTIONS PRESENTED DO
NOT RESOLVE THE DISPLAY ISSUES

If you have updated your graphics driver and are still having problems, you can download this opengl32.dll ZIP file

291 4nd unzip the "OpenGL32.d1l" and the "Glu32.dll" file to the directory where XMS is installed. Close and

re-open XMS so this DLL is used for displaying XMS objects. Placing these DLL's in your XMS directory will fix

most graphics-related issues, such as problems with displaying triangles on large TIN or DTM datasets and other
problems with displaying large amounts of data. The following are known disadvantages to using this DLL for
displaying:

» Displaying graphics using this DLL will likely be slower since software is used to display your graphics instead
of your computer's graphics hardware. Panning, zooming, and rotating operations will be significantly slower.

* Some entities, such as symbols, are currently not displayed correctly when using this DLL. Only squares and
circles will be displayed. Changing all symbol display options to squares or symbols will allow you to work
around this problem. We are currently working on trying to fix this problem of symbols not displaying when
using this DLL. (THIS PROBLEM HAS NOW BEEN FIXED IN SOME BETA VERSIONS OF XMS
COMPILED AFTER March 31, 2009) In general, you will not want to use this DLL unless you are working with
large datasets that have display issues where XMS closes unexpectedly.



http://update.microsoft.com
http://www.aquaveo.com/downloads
http://wms.aquaveo.com/OPENGL32.zip
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Contacting Support

If you continue to experience problems after updating your graphics card drivers, contact support [,

External Links

* Aquaveo Technical Support (h
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Reporting Bugs

The Help | Report A Bug menu command can be used to send a bug report to GMS tech support. Reporting bugs

helps to improve the quality of GMS. An internet connection is required to use this feature.
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3. General Tools




3.1. The File Menu

File Menu

The File menu is one of the standard menus and is available in all of the modules. The commands in the File menu

are used for file input and output for the basic GMS file types, for printing, and to exit the program. The following
commands are contained in the File menu:

¢ New

Deletes all data associated with all data types and all modules. It resets the status of the program to the
default state that is set when the program is first launched. This command should be selected when an
entirely new modeling problem is started.

* Open
This command is most often used to read in project files or other GMS native files. However, the Open
command is also used to import data or other files generated outside of GMS. Projects can either be
opened into the current window which replaces the existing project, or the project can be opened into a
new instance of GMS. This setting is selected in the Preferences dialog that is accessed by the Edit |
Preferences command.

e Import From Database
Allows users to access data stored in a database and import it.

e Import From Web
Allows users to import an image from the world-wide-web.

* Save
Used to save GMS projects. A project contains all of the files associated with a modeling project. When
a GMS project is saved, all files associated with the data currently in memory are saved. This includes
any model simulations which are open. By default the model simulation will be saved to the same
location as the project. However, in the Save dialog the path for the model simulation can be specified.

* Save As
Used to designate the path for saving a GMS project. It can also be used to Export data.

» Edit File
Prompts for the name of a file and opens the file in a program of your choice. This command is used to
edit model input files or to view output files. Output files that are part of a Solution can also be viewed
by double-clicking on the text file in the Project Explorer.

¢ Settings...
This command can be used to change the default settings (display options, units etc) applied to all new
projects. For example, if the user wants new projects to have particular settings, the user can set those up
in GMS and then use the Settings command to to save the Current settings as the defaults to be used in

the future. A user can also stop using defaults that were set previously and restore the defaults to the

Factory defaults There is only one set of default settings.

¢ Page Setup



http://www.xmswiki.com/xms/index.php?title=GMS:Preferences
http://www.xmswiki.com/xms/index.php?title=GMS:Import_From_Database
http://www.xmswiki.com/xms/index.php?title=Import_from_Web
http://www.xmswiki.com/xms/index.php?title=GMS:Exporting_Non-native_GMS_Files
http://www.xmswiki.com/xms/index.php?title=GMS:Datasets%23Datasets_in_the_Project_Explorer
http://www.xmswiki.com/xms/index.php?title=GMS:The_GMS_Screen
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Launches the Page Setup dialog. The Page Setup dialog contains 3 tabs: Margins, Options, and Paper
Size. The Options tab allows the user to specify the printing scale. The Paper Size tab allows the user to
select the paper size and source. Also, the orientation, portrait or landscape, can be selected. The Margin
tab allows the user to change the Margins. On the right side of each tab is a print preview.

e Print
Printed copies of the current GMS image are generated with this command. This launches the standard
Windows Printing dialog.

* Demo Mode
Toggles on and off Demo Mode. Since some users may not require all of the features provided in GMS,
modules and model interfaces can be licensed individually. The icons for the unlicensed modules or the
menus for model interfaces are dimmed and cannot be accessed. Even though you may have only
licensed a portion of the GMS interface, the Demo Mode command provides a way of evaluating
modules you may wish to consider licensing in the future. This is particularly useful when using the
GMS tutorials.
When the Demo Mode command is selected, all modules of the program will be enabled. The only
exceptions are that the Print and Save options will be disabled. To return to normal operating mode,
select the Normal Mode command. (Also See Registering GMS)

* Register
Brings up the Register dialog which allows users to register the software.

* Recent File List
Near the bottom of the File menu is a list of recently opened projects. You can have as many as 5
different files in the recent file list.

» Exit

Terminates the program.



http://www.xmswiki.com/xms/index.php?title=GMS:Registering_GMS
http://www.xmswiki.com/xms/index.php?title=GMS:Registering_GMS
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Project Template Files

GMS project template files have a ".gpt" extension and are similar to project files (".gpr" extension) but they only
store setting information such as display options and not object data such as a grid or TIN. Project template files are
useful for saving and reusing project settings. For example, if you prefer a certain set of units, you can set them up
the way you like and save a project template file. Then, whenever you start a new project, you can start by opening
that template file and the units will be restored to how you like them. To save a project template file, simply use the

Save As command and select "Project Template Files (*.gpt)" as the file type.

Normal Template

The normal template is a project template file named "normal.gpt" which GMS looks for on startup or whenever the
New command is executed. If it finds the file, it reads it and restores the settings found in the file as with any other
project template file. GMS looks in the system AppData folder which, for Windows 7, is something like
"C:\users\(your user name)\appdata\roaming\Aquaveo\GMS".



http://www.xmswiki.com/xms/index.php?title=GMS:Display_Options
http://www.xmswiki.com/xms/index.php?title=GMS:TIN_Module
http://www.xmswiki.com/xms/index.php?title=GMS:Units
http://www.xmswiki.com/xms/index.php?title=GMS:File_Menu
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3.2. The Edit Menu

Edit Menu

The Edit menu is one of the standard menus and is available in all of the modules. The commands in the Edit menu
are used to select objects, delete objects, and set basic object and material attributes. The Edit menu contains the

following commands:
* Delete

Delete the object currently selected in the Graphics Window.
Select All

Selects all items associated with the current selection tool.
e Unselect All
Unselects all items associated with the current selection tool.
e Invert Selection
Selects the items that were not initially selected and are associated with the current selection tool.

Select With Poly

Used to enter a polygon enclosing the items to be selected (one of the selection tools must be active).
This option is useful when selecting a large irregularly shaped group of objects. To enter the polygon,
click on the polygon's starting point and each intermediate point defining the polygon and double-click

on the ending point. All items within the polygon will be selected.

* Select With Polyline
Selects the items that intersect a polyline associated with the current selection tool.

* Select From List
Some of the objects in GMS (TINs, solids, cross sections, and scatter point sets) are selected by
selecting an icon that appears on the object when the selection tool for the object is active. With a large
number of objects, the display of the icons can become complicated and it may be difficult to select the
desired object. In such cases, this command can be used as an alternative method for selecting such
objects. It brings up a list of the objects currently in memory. An object is selected by checking the box
next to it in the list and then hitting the OK button.

¢ Locate Selections

Causes a rectangle to be drawn on screen and move to surround the location of the selected items,
helping to see where they are.

* Selection Window
When objects are selected, various information about the objects can be displayed or saved. The values
are displayed by default in the Status Bar at the bottom of the GMS main window. However, since space
along the bottom of the window is limited, the user has the option of displaying the information to a
separate window and echoing the information into a file. The Selection Information dialog allows you to

turn on and off the echo of the information to a file and to a separate, dockable window.

¢ Select By Dataset Value



http://www.xmswiki.com/xms/index.php?title=GMS:TIN_Module
http://www.xmswiki.com/xms/index.php?title=GMS:Solid_Module
http://www.xmswiki.com/xms/index.php?title=GMS:Main_Window
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When the current tool corresponds to one which selects nodes or cells and there is a dataset associated
with the nodes or cells, this command lets you select the nodes/cells based on the dataset values. You

must select either the less than or greater than options, or both.
* Dataset Calculator

The Data Calculator can be used to perform mathematical operations with datasets to create new

datasets.
* Properties

This command brings up the Properties dialog for the currently selected item. This dialog varies

depending on the selected item.
* Materials

Brings up the Material Properties dialog.
* Model Interfaces

Bring up a dialog containing all of the models, allowing the user to define which model menus are to be

static in the menu bar.
* Units

Brings Units dialog which allows the user to adjust the units for the model.
* Projection...

The projection currently associated with the project can be specified via this command. Changing the

projection does not alter the XYZ coordinates of the project data.
* Reproject...

Reprojecting means to convert data from one coordinate system to another.
* Single Point Reprojection...

This option can be used to view the coordinates of a point to be transformed.
* Transform...

This command is used to scale, rotate and translate the entire project. Clicking on this command will
bring up the Transform dialog. Individual objects can be transformed by using the same command found

in right-click context menus for the item in the Project Explorer.
* Preferences

Brings up the Preferences dialog where the user can adjust the general preferences for GMS.
* Screen Capture...

Images in the Graphics Window can be copied to the Windows clipboard by selecting the Copy
command from the Edit menu. Once on the clipboard, the image can be copied into other applications
for report generation. If the user wants to copy an image that is larger or smaller than the graphics

window this can be done by editing the copy scale factor in the Preferences dialog.
* Paste Text

The Paste command in the Edit window allows the user to paste tabular data directly into GMS. When

this command is executed the File Import Wizard is launched.
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http://www.xmswiki.com/xms/index.php?title=GMS:Transform
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Obsolete Menu Items
The following commands have been removed from current versions of GMS:
¢ Coordinate System

Brings up the Coordinate System dialog which allows the user to adjust the current horizontal and

vertical coordinate systems.
* Coordinate Transformation

Brings up the Coordinate Transformation Wizard which allows the user to perform geographic system

transformations, translations, rotations, and scaling.

Units

When building a ground water model, it is important to .
ensure that consistent units are used when entering Units &J

model parameters. To simplify the management of

model units, the user can define the units for length, Length:

time, mass, force and concentration in the Units dialog. T

A units label is placed next to each of the input fields in
all the model dialogs in GMS where the units are Mass: B
known. For example, the wunits for hydraulic e
conductivity are length / time. If the length units are

==
10
4 4 4

defined as "m" (meters) and the time units are defined Concentration: | mg/l

as "d" (days) in the Units dialog, then the units string

next to the hydraulic conductivity input field would be Help... ] [ 0K ] I Cancel |

"m/d". MOTE: These values do not affect model input
values.

Concentration units can be defined separately, and

potentially inconsistently with, mass and length units. L

This allows for more flexibility but can also lead to The Units dialog.

confusion so you should use care when selecting

concentration units.

The Units dialog is accessed by using the Units... in the Edif menu.

Unit Conversion

Generally speaking, GMS does not convert quantities from one system of units to another. GMS only displays
the chosen units to help the user make sure they are being consistent. However, in a few places, GMS will use
the currently defined units in it's calculations. These include:

* inthe FEMWATER Fluid Properties dialog
* in the Curve Generator dialog

* when calculating the stream stage constant when saving MODFLOW, and

¢ in the measure tool.
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Preferences

The Edit |

brings up the Preferences dialog.

Preferences command

General

The General tab has all the of the
general options in GMS.
* Restore Factory Preferences

This button switches all
settings to
defaults.

the factory

¢ Show welcome dialog on startup
* Check for newer version on startup

¢ Confirm Deletions

Whenever a set of selected
objects is about to be

deleted, the wuser can

@ Preferences Iﬁ
Model Executables || Show welcome dialog on startup
! ;3
g‘lgg;;?—'v [7] Check for newer version on startup
Images / CAD [] Corfirm deletions
Prirting =i ) )
Program Mode || Show new project wizard on startup
Map
gLr:J:holes File compression
Scatter sets [¥] Compress project files Compression factor: 1
20 Mesh
Graphics Project Explorer
[¥] Change module when Project Explorer selection changes
[ Scroll Project Explorer when changing the module
il Synchronize active data set and Z elevations for TINs, 2D Meshes,
12D Grids, and 2D Scatter Sets.
Contouring
Filed contour tolerance:  0.01
MNorth amow path
Path: C:\Users\jcreer\Documents®GMS 5. 1%NorthAmows Browse
Help.. Restore Factory Preferences

The Preference dialog showing the General tab

choose to be prompted to confirm the deletion. This is meant to ensure that objects are not deleted

accidentally.

* Show new project wizard on startup
* XMDF File Compression

When saving XMDF files, you can use compression. The compression factor can be specified.

* Project Explorer

The Project Explorer section allows the user modify preferences related to the Project Explorer.

* Change Module when tree selection changes.

This option changes the current module when a item is selected in the Project Explorer. This option is on

by default.

* Scroll Project Explorer when changing module.

This option will ensure the visibility of the tree item objects in a certain module when the module is

changed.

* Synchronize active dataset and elevation dataset for TINs, 2D Meshes, 2D Grids, and 2D Scatter Sets.

* Contouring

Allows the user to enter a filled contour tolerance.

* North arrow paths

Specify the path to the folder containing the North Arrows.
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Model Executables
The Models page allows the user to 5
. p g . @ Preferences &J
specify the location of model
General
executables, as well as the option to IR
SEAWAT Madel Executable | -
use the Model Wrapper. e ADH NOT DEFINED Browss...
anggil Mode FEMWATER c\program files'gms 9... |  Browse... |=
° MOdel W”apper Il\'ql?slps FIELDGEN c:\program files'gms ... Browse...
. Boreholes GAMEAS c\program files'gms 9... Browse...
GMS 18 a pre_ and gga{tqee;;as Gms2Mf 2 c:\program files'gms 9... Browse...
post—processor fOI' Graphics MCMOD c:\program files'gms 9... Browse...
) MFZPEST c:program files'\gms 9... Browse...
Numerlcal MOdelS. MOSt MFS6TOZK c:\program files\gms ... Browse...
Of these numerical mOdelS MODAEM c:\program files'\gms § Browse
MODFLOW 2000: 32 bit c:\program files'gms §... Browse...
are run externally in the MODFLOW 2000: 32 bit, Parallel cA\program fles\gms 9., | Browee...
. MODFLOW 2000: 32 bit-DBL c:program files'gms §... Browse...
DOS environment. The MODFLOW 2000: 32 bit-DBL, Parallel | c:“\program files\gms 3... Browse...
default Opti()n is to use the MODFLOW 2000: &4 bit c\program files\gms 9...|  Browse...
MODFLOW 2000: 64 bit, Parallel cprogram files'ams 3. | Browse... 5
Model  Wrapper. The
|| Use Model Wrapper
Model Wrapper "wraps"
. Help... Restore Factory Prefi OK Cancel
itself around the same i [Boser oo Profronces ) ()

DOS

gives

executables  and The Preferences

more model

feedback including graphs and tables. The Model Wrapper includes a toggle box in the bottom left that,
when checked and you exit the Model Wrapper, GMS will automatically read in the results of the
solution. This toggle will only be checked by default if the model converged. The option to use the
Model Wrapper or the old DOS view is included in the Preferences dialog. Certain models, including

Stochastic and inverse modeling, can only be run using the Model Wrapper.

Parallel versions of MODFLOW-2000, MODFLOW-2005, and SEAWAT are shipped with GMS to run simulations.
Beginning with version 8, GMS ships parallel versions where the SAMG solver has been parallelized. Even when
this option is on, when running Parallel PEST with MODFLOW the serial (non-parallel) version of MODFLOW will
be used since the Parallel PEST will use all of the available cores on the computer with the serial version. Also see

MODFLOW preferences for an option to turn on or off the parallel version.

MODFLOW

The MODFLOW page has options related to the MODFLOW interface in GMS.
* Compress MODFLOW HS5 files
This option will force the HS files saved with MODFLOW to be compressed. Generally this option

should be turned on.

* Create h5 copy of head solution
Turning on this option can speed up reading the MODFLOW head solution especially when there are a
large number of stress periods. When this option is on, GMS writes an HDF5 copy of the MODFLOW
head solution upon reading it the first time. The following times GMS reads the head solution, it doesn't
take as much time.

* Save copy of MODFLOW simulation in native text format

This option will create an additional MODFLOW directory when the GMS project is saved that will contain
native MODFLOW text files of the MODFLOW simulation. The new directory will be named as follows
myProject. MODFLOW _text. There are 3 additional preferences with this option. You can specify that all
arrays be written internally in the MODFLOW files (default option), all arrays are external from the
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MODFLOW files, or all arrays are external and are placed in a directory named arrays.
External arrays are placed in their own text files and are named as follows
myProject_array_ PACKAGE_VARIABLE LAYERorSP. For example the ibound array for layer 1 would have
the following name myProject_array_BAS_IBOUND_1.txt. The recharge array for stress period 3 would have
the following name myProject_array RCH_RECH_3.txt.
* Use custom Run dialog when running MODFLOW
This option will bring up the Custom Run MODFLOW dialog when the MODFLOW | Run
MODFLOW menu command is selected.
Default version of MODFLOW to run
Allows the user to select version of MODFLOW to be used as a default when GMS is started.

* Double precision
When this option is on, GMS will use the double precision version of MODFLOW to run simulations.
By default this option is off and GMS uses the single precision version of MODFLOW.

e Parallel (not used by Parallel PEST)
When this option is on, GMS will use the parallel version of MODFLOW to run simulations. Beginning
with version 8, GMS ships parallel versions of MODFLOW where the SAMG solver has been
parallelized. Even when this option is on, Parallel PEST will use the serial (non-parallel) version of

MODFLOW since the Parallel PEST will use all of the available cores on the computer.

@ Preferences ﬁ
General .
Model Executables [
MODFLOW )
SEAWAT Create h5 copy of head solutior
|PI'I1_IE_'tg_ES /CRD [ Save copy of MODFLOW simulation in native text format
finting
Program Mode Write intemal amays
Map
TINs [7] Use custom Run dialog when running MODFLOW
Bareholes .
Scatter sets Default version of MODFLOW to run
20 Mesh -
Graphics ? AL
(©) 2005
@ NWT

© LGR

© USG

[] Double precision

Parallel {onty SAMG solver parallelized. not used by Parallel PEST)

[T 64 bit
Help Restore Factory Preferences

The Preferences dialog showing the MODFLOW tab.
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Images / CAD

¢ Bitmap Scale Factor - N
p @ Preferences M
When the copy command —
. . . Model Executables Images
is selected, a bitmap image MODFLOW
' Pyramids: | Never buid -]
of the screen is placed on
Draw order: [Top drawn last ']
. Program Mode
the clipboard. The scale Map
TIMs Secreen capture
faCtOr can be used to EE:&T?;S Bitmap scale factor: [
increase :or decrease the b I¥] Confimn scale factor before copying
resolution of the bitmap. i _
(@ Draw points and symbols as points
Thls Scale factor also () Draw points and symbols as shapes

Specify CAD symbols size

applies when saving the -

image as a bitmap.
e CAD Symbol Size

The size of the CAD
symbol display can be

specified.

The Preferences dialog showing the Images / CAD tab
Printing

Allows the user to specify scaling Points, Lines, and Fonts while printing.

r@ Preferences ﬂ1

General
Model Executables ‘When prirting points, lines, and fonts can be scaled to match how they appear on the
MODFLOW screen or they can be displayed relatively smaller when using a printer with a higher
SEAWAT resolution than the screen.

Images / CAD

inting
rli‘,‘mgmm Mode [¥] Scale Lines
3
T|Np5 Scale Fonts
Boreholes
Scatter sets
20 Mesh
Graphics

The Preferences dialog showing the Printing tab



http://www.xmswiki.com/xms/index.php?title=File%3APreferencesImagesCAD.jpg
http://www.xmswiki.com/xms/index.php?title=File%3APreferencesPrinting.jpg

Preferences

29

Program Mode

GMS has the option of changing the \
X p . g g A @ Preferences &J
"mode" or "skin" that GMS is running.
General
The purpose of the mode is to simplif Mode| Executables
p rp . . . p y gqggglﬁ_‘""‘ Program Mode:  [GMS -
the items available in the interface. mages / CAD
Printing In this mode: all of t GM 20 }r.
G Ste
Map TPROGS
. TIMs
Available Modes Borsholes
Scatter sets
2D Mesh
° GMS Graphics
This is the default mode
where are the tools are
available to the user.
e GMS 2D
GMS 2D is for users that
are only interested in
using GMS to do seepage Help

and slope stability. In
GMS 2D mode the only

tools that are available are

The Preferences dialog showing the Program Mode tab.

the 2D mesh and the Map. There are several changes to the GMS interface when in this mode,

including:

1. Hiding of tools and modules not in use

2. SEEP2D model automatically initialized from conceptual model

3. SEEP2D boundary conditions automatically mapped from conceptual model (no need to run Map ->

SEEP2D)

4. Easily create all coverage types in one step

5. Feature object types automatically assigned based on coverage attributes

6. Allow only one conceptual model

* GMS Site

GMS Site is for users that are only interested in using tools for site characterization. As such the tools

available in this mode are TINs, Boreholes, Solids, 2D Scatter, and Map. These tools can be used to

construct solid models of stratigraphy.
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Caveats

When GMS is running in a particular mode then only data associated with the available tools will be read into GMS.
For example, if I have a GMS project file that contains a 3D Grid, and I am running in "GMS 2D" mode then when I
attempt to read in the project file I will get a message that GMS is not enabled to read in 3D Grid data. The only data
that will read into GMS in "GMS 2D" mode is data associate with the 2D Mesh and the Map.

Map
Gives the wuser the option to .
. p @ Preferences &J
automatically perform the
G |
Map—SEEP2D command. Model Executebles [V Automatically pertorm Map->5EEF2D command after editing attnbutes :
MODFLOW
SEAWAT
Images / CAD
Prirting
TINS Pr::uglam Mode:
TINs
Boreholes
. Scatter set
The TINs tab has the following 20 Mesh
. Graphics
options:
* Vertex options
* Retriangulate after deleting
Default z-value
¢ Confirm z-value
* Interpolate for default z on
interior
» Extrapolate for default z on |
exterior The Preferences dialog showing the Map tab.

* Breakline options
* Add supplementary points
* Swap edges

*  Minimum length ratio

For more detailed information, see TIN Settings.
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Boreholes

* Auto-assign horizons
Rows per lift

Row overlapped between
lifts

Sets retained between lifts

* Measure slope from borehole tips
Average horizon slope
Horizon slope weight
Gap weight

* Auto-Fill cross sections

* Prompt for vertex spacing

* Do not redistribute vertices

* Use default spacing
Default

ratio

spacing/length

Max. lense thickness ratio

Scatter sets
* 2D scatter
Default dataset value
* Confirm date set value
* 3D scatter
Default dataset value
Default Z value

¢ Confirm date set value

r ~
@ Preferences @
General
Model Executables Auto-assign horizans
MODFLOW o
SEAWAT Rows per lift:
Images / CAD Rows overapped between lifts:
Prirting
Program Mode Sets retained between lifts:
Map
TIMe Measure slope from borehole tips
Scatter sets Average horizon slope: 0.01
2D Mesh
Graphics Horizon slope weight: 10
Gap weight: 10
Auto-Fill cross sections
() Prompt for vertex spacing
() Do not redistibute vertices
@ Use default spacing
Default spacing/length ratio: 0.1
Max. lense thickness ratio: 025
Help. Restore Factory Preferences

The Prefences dialog showing the Borehole tab.
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r ™
@ Preferences @
General
Model Executables 20 scatter
MODFLOW :
SEAWAT Default data set value: [
Images / CAD [] Corfirm data set value
Printing
Program Mode 3D scatter
Map S
TINs [ 0.0
Baoreholes —
Scatter sets o
éDlaSqlfig: Corfim data set value
Help... Restore Factory Preferences

The Preferences dialog showing the Scatter Sets tab.

* Ask which library to use if system does not support all functionality

* Autoselect the software library if system does support all functionality

* Always use system library (may not support all features)

* Always use software library (may be slower)

g ™
() Preferences @
General
Model Executables Active graphics library
g"lggl:;?_"\" () Ask Asle which library to use if system does not support all functionality
IPrnages JCAD () Autoselect  Use software library if system does not support all functionality
rirting
Program Mode Always use system library (may not support all features)
ap
TINs =
Borchiolo (") Software Plways use software library {may be slower)
Scatter sets
20 Mesh
Help.. Restore Factory Preferences
.

The Preferences dialog showing the Graphics tab

2D Mesh

The 2D Mesh tab in as the following

options:

 Interpolate for default z on interior
Default z (ft)

* Assign default z-value

e Prompt for z-value

* Insert nodes into triangulated mesh
¢ Check for coincident nodes

» Retriangulate voids when deleting
Thin triangle aspect ratio

For more information, see 2D Mesh

Settings.

Graphics

Related Topics

¢ Edit Menu
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Materials

Many of the data types supported by GMS (ex., elements, solids, borehole regions) have a material ID associated
with each object. This material ID is an index into a list of material types. These material types often represent
different types of soil or rock. A global list of material attributes is maintained that can be edited using the Materials
command in the Edit menu.

The Materials are listed in a table or spreadsheet. New materials can be created by typing

'

button. Insert, delete, move up,

0
in the last row, or by copying and pasting from a spreadsheet, or by selecting the Insert ZI+E| %"l "

. . . . . move down buttons
Materials have an ID, name, color and pattern. If a numerical model interface is active

(MODFLOW, FEMWATER etc.), the Materials dialog will show a tab control for each
active model. Additional columns in the spreadsheet are added which correspond to the appropriate properties for the
model.

A legend showing all the materials can be displayed in the Graphics Window. The legend can be turned on and off in
the Display Options dialog.

The material names, colors, patterns, and transparencies can be exported by selecting the Export button. This will

save out a "material" file with a *.mat extension. This file can be imported into GMS using the File | Open

command.
(@ Moters @ Related Topics
HoBFoW e Edit Menu
D ‘ Name | Color/Pattem ‘ Transparency (%} Hor‘i;:fr;t:'a\ k ‘ Ve(':r:ﬁ::k Horiz. anisotropy ‘ Ven{z:}i(?at]r
A | |
1|1 | material_1 | NENN[~| 0.0 00 00 10 a0

4 LI} L3

[Ze2 2 3]

| ] (B

An example of the Materials dialog.
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Material Set

A material set is similar to a dataset but represents materials instead of

Haterials

Sand_wi_fines

dataset values. Material sets can exist with 3D grids and meshes and can
be created manually or by running a T-PROGS simulation. To create a
material set manually you can right-click on the 3D grid or mesh in the
Project Explorer and select the New Material Set command. Doing so
will create a material set from the current cell or element materials. All
Material sets are grouped under a Material Sets folder in the Project
Explorer. Although grid cells and mesh elements (as well as other 3D grid showing materials from a material set.
objects) have materials associated with them from the start and these

material assignments can be changed on a cell-by-cell (or

element-by-element) basis, a material set is not created until you = bl 30 Gid Data

- e . = B grid
specifically create it. Clicking on a material set causes the set to be i[5 elevation
applied to the grid cells (or mesh elements) and the material Euﬂ Material Sets
assignments of the cells updated. B Material Set

E-gd Simulation
o Simulation 1

PI'Opel’tieS A material set in the Project

Explorer.

As with datasets, a material set has properties that can be viewed.
Right-clicking on the material set in the Project Explorer and selecting the Properties command brings up the
Material Set Info dialog. This dialog lists the materials in the material set, their frequency and percentage. A

histogram is also drawn showing the frequency of the different materials in the set.

Viewing / Editing
Clicking the Edit Materials button in the Material Set Info dialog brings up a table showing the materials in the

material set, similar to viewing values in a dataset. The materials can be edited and saved.

Inactive Values

As with datasets, materials sets can include inactive values (starting at GMS version 8.0). Inactive materials are
rendered using a material with ID -9999999.

Material Set Solutions

TPROGS can generate multiple material sets as part of its solution. These are stored in a material set solution folder

which is locked against editing. Material set solutions can be used to run a stochastic simulation in MODFLOW.
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An example of the Material Set Info dialog.
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3.2.1. Coordinate Systems

Coordinate Systems

XMS programs work in a single coordinate system. The user selects what system will be used using the Edir |

Coordinate System menu command.

Both a horizontal and vertical system are specified. Many numerical models work in a local system, so there may not
be a problem if the user does not know what coordinate system the data is referenced to. If the desired model
requires a global system, or the base data is referenced to more than one system, the modeler must determine the
coordinate systems involved.

Since data can be gathered and referenced to various coordinate systems, XMS allows the user to convert data from
one coordinate system into another. The Coordinate Conversions page describes how to do this. The available
systems and units include:

Horizontal System

The options to the right of the dialog change as the horizontal system is changed. For example, the hemisphere is

required for a Geographic system and a UTM zone is required for a UTM system.

* Local

* Geographic
« UTM

» State Plane
« CPP

Local is the default horizontal and vertical system. Unless the user desires to convert data to another system, it is not

necessary to change the system from Local.

Horizontal Units

The horizontal units can be specified for all systems except Geographic, which uses decimal degrees. The units set
here are the units used by the models such as RMA2.

* U.S. Survey Feet
e International Feet
e Meters

Ellipsoid
The Ellipsoid options are only available for non-NAD/HPGN/CPP systems. The ellipsoid can be selected for a

region of the world. Changing the ellipsoid changes the minor and major radii of the earth, measurements used in
performing conversions. To set the radii for an ellipsoid not included in XMS, select the User Defined ellipsoid and a
button appears titled Define. Clicking on the button brings up a dialog where the radii are defined. The Major and
Minor Radii (a and b, respectively) are defined in meters only. The Minor Radius can be input directly or defined by
specifying the ellipsoid flattening (1/f) or eccentricity squared (e2) variables, where

1 (a—b) : iz
TmiT—E ﬁﬂd E = 1 TR
f a a
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Vertical System

The supported vertical options are for North America. If a non-NAD/HPGN horizontal system is selected, this option
is disabled.

¢ Local

A system defined for a survey that may or may not relate to a global coordinate system. For more

information, see Local Coordinate System
e« NGVD 29
NGVD 29 (The National Geodetic Vertical Datum of 1929) is a vertical geodetic datum formerly called

"Sea Level Datum of 1929" or "mean sea level". The datum was found by averaging the sea level over a
period of many years at 26 tide stations along the coasts of the US and Canada. Because it is an average,
it does not represent the local mean sea level at any particular place. Conversion to NAVD 88 is done by

interpolating between data points between the two data.
* NAVD 88
NAVD 88 (The North American Vertical Datum of 1988) is a vertical geodetic datum created in 1991

from measurements in Mexico, the US, and Canada. NAVD 88 was computed due to land distortions
over time from the NGVD 29 measurements. Conversion to NGVD 29 is done by interpolating between

data points between the two data.

Vertical Units

The vertical unit is only used for conversions. Area and volume calculations performed by XMS use the horizontal

units.

e U.S. Survey Feet
¢ International Feet

e Meters

External Links

[1] [2]

e Introduction to Tidal and Geodetic Vertical Datums and Datum Computations * ' — Presentations available here

References

[1] http://www.ngs.noaa.gov/corbin/class_description/Tidal_Geodetic_Datums.shtml
[2] ftp://ftp.ngs.noaa.gov/pub/corbin/datum_training/
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Coordinate Conversions

Converting data from one coordinate system to another can be done using the EdirlCoordinate Conversions menu
command. The command may also be accessed by right-clicking on a single entity (grid, mesh, scattered data set ...)
in the Project Explorer. This allows the user to convert just that entity from one system into another (typically to the

current project coordinate system).

All data will be converted from the system on the left of the dialog to the system on the right.

"Convert From' System

The "Convert From" system defines the coordinate system the data is currently referenced to. When working from
the Edit menu, this is the system XMS is working in and is dimmed by default because it is assumed you have
already specified this system. When working from the Project Explorer, this is the coordinate system of the selected

entity and must be selected.

"Convert To' System

The "Convert To" system defines the system you will be working in after the conversion. When the dialog is invoked
from the Edit menu, this is selected by the user and all data is converted from the current system to this new system.
When the dialog is invoked from the Project Explorer, the "Convert To" system is dimmed because this is assumed

to be the system XMS is working in and all other data is already in this system.

Restrictions

Some conversions are not allowed, such as converting between a NAD and non-NAD system. A warning is issued

when conversions are not allowed.
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Projections

Related Versions

GMS |vo.1

SMS vll.l

version note

"Projection"” refers to a map projection like UTM 1 1n xMS software, a projections are associated with the project

and individual data objects.

Starting with SMS 11.1 and GMS 9.1, the XMS software works on the concept of a "Display Projection". This is the
projection the user is working in. Each geometric object loaded into the XMS package, such as a Scatterset, DEM,
grid or mesh, also has an associated projection. These two projections may not be the same. If the two projections are
compatible (i.e. it is a viable option to convert from one projection to the other), the XMS package will convert the
data from the object projection to the display projection, just for display purposes. This is referred to as "Project on
the fly". The data itself maintains the values associated with the object projection so when the XMS package saves a

project, the data files are not modified.

Alternatively, data can be reprojected from one projection to another, actually changing the data values that will be
saved as part of a project. This is done by right clicking on the geometric object in the project explorer (data tree)
and selecting the "Reproject..." command. The SMS package includes a feature to reproject all data from whatever

projection the data is currently in to a single projection using the "Reproject All..." command in the Display menu.
XMS software utilizes the Global Mapper (TM) 21 library which supports hundreds of standard projections.

Previous XMS software versions referred to projections as "coordinate systems" and reprojection as "coordinate

conversion".

Display Projection

The display projection, or the projection currently associated with the project, can be specified via the
DisplaylProjection menu command. This setting controls how the XMS application displays (or interprets) data.
Data defining objects with a specified projection are converted to the display projection (if it is different from the
object projection) for display purposes only. This is referred to as "projection on the fly". The data saved to files as
part of a project, or exported for a simulation are exported in the object projection. Display projection only affects
the display.

Objects without a specified projection are assumed by the XMS application to be referenced to the display
projection.

The display projection is saved as part of a project file. The user can specify a display projection as part of the

system settings for new sessions/projects.

When a data object is read into an XMS application, for which no data has yet been loaded and no projection has
been specified, and the data object has its own projection, the display projection is reset to the object projection. This
allows a user to define a working projection simply by loading data that uses that projection (and has a projection

definition such as a .prj file to define it.)



http://en.wikipedia.org/wiki/Universal_Transverse_Mercator_coordinate_system
http://www.globalmapper.com/
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No Projection (Previously Local Projection)

Many numerical models work in local or model space, and don't care how that system relates back to global
coordinate systems (UTM, State Plane etc.). XMS software allows for this using a Display projection set to local or
no projection option. This is standard practice when building a numerical model of a flume test. The units of the
model are also specified as part of the projection. If the display projection is in this mode, no global projections are

allowed on individual objects.

(Note: when the display projection is set to No Projection or Local Projection, the data may still be referenced to a

projection. The display projection can be changed to reflect that projection if desired.)

Global Projection

Data referenced to a global projection can be easily correlated and used with other applications that utilize
projections including GIS and CAD. When the display projection is specified as a global projection, the XMS
application can export georeferenced images, shapefiles, and kmz files that may be directly imported to other
applications.

Object Projection

Each geometric object loaded into a session can have an associated projection. When an object is loaded from a file,
the XMS application looks for a projection either in the object data file or in an associated ".prj" file. If no projection
is found, the object is left with no projection or floating. In this case, the object is assumed to be related to the
display projection, regardless of what that projection is. The object projection can be specified by right clicking on
the object in the project explorer and selecting the "Projection..." command. The default projection displayed in the
dialog that appears is the object's projection if it has one, and no projection otherwise. In the case of no projection,
the display projection is filled in as the default global projection should that option be selected.

Reproject

Reprojecting means to convert data from one coordinate system to another. For example, a 2D mesh representing the
ground surface may have XYZ coordinates in a UTM system and they need to be converted to a State Plane system
to be consistent with other data. Reprojecting results in the XYZ coordinates of the data changing, although
conceptually the data is in the same place with respect to the Earth, just in a different projection or coordinate

system.
There are four basic reprojection tasks that you can do:

* Reproject on the fly, which just displays all data in a specified projection without changing the base values

* Reprojecting the entire project from one system to another

* Reprojecting one geometric object (i.e. mesh or grid) from one coordinate system to another

* Single point reprojection, which allows you to enter the XYZ coordinates for a point in one projection and see

what the new coordinates would be if the point was reprojected to a different projection.
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Reproject on the Fly

When data from multiple projections are loaded into and XMS application, without a defined projection, they do not
overlay and the display shows data clusters at two distinct locations. With project on the fly, if the data object has a
defined projection (such as a .prj file), this data would be reprojected on the fly to the display projection.

If data does not line up due to incorrect or incomplete projection specification, the user can specify different object
projections to attempt to align the data correctly. Object projection is specified by right clicking on the object in the

project explorer.

Reproject everything

Reprojecting everything can be done by selecting the DisplaylReproject All... menu command. This will convert all
the data loaded into the XMS application from the object projection(s) to a specified projection. This operation
brings up a dialog which allows the user to specify the desired projection. The default value is the display projection

currently specified for the project.

Reproject object

This command is done on a specific geometric object (grid, mesh, scatter set, ...) by right-clicking on the entity in the
Project Explorer and sececting "Reproject...". If the object does not have a specified projection, this command is not
available. It can be accessed by selection the "Projection..." command for the object in the same right click menu and

defining a projection for the object.

When the object has a projection, this command reprojects from one projection to another. The command brings up a
dialog with a "from" projection specified on the left and a "to" projection specified on the right. The "from"

projection is defaulted to the object projection. The "to" projection is defaulted to the display projection.

Single Point Reprojection

Single Point Reprojection command is found in the Display menu and allows you to enter the XYZ coordinates for a
point in one projection and see what the new coordinates would be if the point was reprojected to a different

projection. It also lets you create a feature point at the new location.

Restrictions

Some reprojections are not allowed, such as reprojecting between a NAD and non-NAD system. A warning is issued

when the reprojection is not allowed.

Supported Projections

XMS software utilizes the Global Mapper (TM) 21 library which supports hundreds of standard projections.

References

[1] http://en.wikipedia.org/wiki/Universal_Transverse_Mercator_coordinate_system

[2] http://www.globalmapper.com/



http://www.globalmapper.com/
http://en.wikipedia.org/wiki/Universal_Transverse_Mercator_coordinate_system
http://www.globalmapper.com/

CPP Coordinate System

42

CPP Coordinate System

A CPP (Carte Parallelo-Grammatique Projection) system is a local system. The origin of the system must be defined
in latitude/longitude decimal degrees.

The conversion from of a point from latitude/longitude to CPP is:

HE"W]:IDIHt-E =TTk (p{jllﬂ'longitude - ﬂrlglnlongitude) * COS (Drlglnlatitude)
newpoint, = pointy,,gitude * R

The conversion of a point from CPP to latitude/longitude is:
ﬂrlglnlcrngitude - pﬂll’lt_z

R % cos (Drlglnlatitude)

NEWpo lnt'lﬂngitude =

point,

R
R = 6378206.4m.(Clarke 1866 major spheroid radius)

ne“rpo lnt Iatitude =

Geographic Coordinate System

A Geographic system is a latitude/longitude system defined in decimal degrees. Supported Geographic systems
include:

¢ NAD (North American Datum) 1927 and NAD 1988

* 33 world ellipsoids and a user defined ellipsoid (i.e., Clarke 1866, WGS 1984, etc.)

The hemispheres are defined for non-NAD systems. The hemisphere cannot be changed for NAD systems (Northern,
Western hemispheres).



http://www.xmswiki.com/xms/index.php?title=File:Cppcoordsys1.jpg
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Local Coordinate System

A local coordinate system is a system defined for a survey. Many numerical models work in local systems, and don't
care how that system relates back to global coordinate systems (UTM, State Plane etc.). If a portion of the data for a
project is referenced to a global coordinate system, and a portion is in a local system, a transformation to convert all
the data to a single system must be defined. This can be done by defining the location and orientation of the origin of
the local system with reference to the global system. This allows the data to be referenced back to the global system

or to another local system.
Three scenarios are possible when dealing with local coordinate systems:

1. Global to Local — When converting from a global to a local coordinate sytem, the global coordinates of the origin
of the local coordinate system must be defined using the Local Origin button in the lower portion of the dialog.
This dialog can also be used to enter the angle of rotation of the local coordinate axes relative to the global
coordinate axes. The angle is measured ccw from the positive x-axis.

2. Local to Local — When converting from one local coordinate system to another local coordinate system, the same
approach is used as when converting from a global to local coordinate sytem. The Local Origin dialog is used to
define the coordinates of the origin of the new coordinate system relative to the old coordinate system.

3. Local to Global — When converting from a local to a global coordinate sytem, the Local Origin dialog is used to
coordinates of the local coordinate system (which is the old system in this case) relative to the new global

coordinate sytem.

Coordinate Transformation

Coordinate Transformation means changing the position (xyz coordinates) of data. There are two ways to access

this feature:

» Edit| Coordinate Transformation menu command. Accessed this way the command will transform all your
data.
* Right-click on an object in the Project Explorer and select the Transform command. This transforms just the

object clicked on.

Coordinate Transformation Wizard

Doing either of the above will bring up the Coordinate Transformation Wizard. There are two steps.

Step 1 - Choose the method of transformation
The two options are:

* Geographic system transformation. This option is used to transform from one coordinate system to another.

» Translate, rotate, scale. This performs a simple transformation to move, scale, or rotate your data.

Step 2 - Choose transformation options

Geographic system transformation option

All data will be converted from the system on the left of the dialog to the system on the right.



http://www.xmswiki.com/xms/index.php?title=GMS:The_GMS_Screen%23Project_Explorer
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"Convert From'' System

The "Convert From" system defines the coordinate system the data is currently referenced to. When working from
the Edit menu, this is the system GMS is working in and is dimmed by default because it is assumed you have
already specified this system. When working from the Project Explorer, this is the coordinate system of the selected
entity and must be selected. You may edit the current coordinate system by selecting the check box at the top of the
dialog.

"Convert To'" System

The "Convert To" system defines the system you will be working in after the conversion. When the dialog is invoked
from the Edit menu, this is selected by the user and all data is converted from the current system to this new system.
When the dialog is invoked from the Project Explorer, the "Convert To" system is dimmed because this is assumed
to be the system GMS is working in and all other data is already in this system. In the convert to section you may

select the horizontal and vertical system to be used after your conversion.

Restrictions

Some conversions are not allowed, such as converting between a NAD and non-NAD system. A warning is issued

when conversions are not allowed.

Translate, rotate, scale option

If the Translate, rotate, scale option was selected in step one, step two lets you chose to either translate, rotate or
scale. You cannot do more than one transformation at a time - for example you cannot translate and scale at the same

time. If you want to do both, you can perform the translation first, then perform the scale.

See Also

¢ Transform



http://www.xmswiki.com/xms/index.php?title=GMS:Transform
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Transform

The Transform command is used to
move objects. In the Transform dialog,
the transformation type can be chosen
and then appropriate parameters can be
entered. The following transformation
types are available:

* Scaling: Scaling factors for the X,
Y, and/or Z directions are entered.
To prevent scaling a specific
direction, the default value of 1.0
should be used.

e Translation: Translation values for
the X, Y, and/or Z directions are
entered. To prevent tranlation in a
specific direction, the default value
of 0.0 should be used.

Transform

@ Scale

¥ 1.0

Y. 1.0

| Frame image after transformation

Translate Rotate
¥ Angle: |00
v (0.0 Fods location:
— ¥ |0
£ |ud
y: (0.0
oK || Cancel

Transform dialog

* Rotations: When rotation is selected, the set of options on the right side of the dialog become available to define

the center of rotation around the Z axis. The rotation will occur counter-clockwise by the specified angle around

the specified center of rotation.

By default, the image will be framed after the transformation takes place. However, this can be turned off by using

the Frame image after transformation option.

See Also

¢ Coordinate Transformation
¢ Edit Menu



http://www.xmswiki.com/xms/index.php?title=File%3ATransformDialogGMS.png
http://www.xmswiki.com/xms/index.php?title=GMS:Coordinate_Transformation
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3.3. The Display Menu

Display Menu

The Display menu is one of the standard menus and is available in all of the modules. The commands in the Display

menu are as follows:
¢ Display Options
Brings up the Display Options dialog.
¢ Contour Options
Opens the Contour Options dialog.
* Refresh

When editing the image in the Graphics Window it occasionally becomes necessary to update the
display or refresh the screen by redrawing the image. Whenever possible, GMS automatically updates
the display. However, in some cases small parts may be obscured by editing procedures. If so, the
display can be refreshed by selecting the Refresh command from the Display menu. After selecting the

Refresh command, the display process can be aborted by pressing the ESC key.
¢ Refresh Display

When editing the image in the Graphics Window it occasionally becomes necessary to update the
display or refresh the screen by redrawing the image. Whenever possible, GMS automatically updates
the display. However, in some cases small parts may be obscured by editing procedures. If so, the
display can be refreshed by selecting the Refresh Display command from the Display menu. After
selecting the Refresh Display command, the display process can be aborted by pressing the ESC key.

¢ Redraw Display

When zooming in and out in the Graphics Window some items such as arrows change size for increased
drawing speed. This command refreshes the display and redraws these items at the size specified in the
Display Options.

* Frame Image

After altering the image display using the Zoom or Pan tools, the image can be centered by selecting the
Frame Image command in the View menu. This command adjusts the window boundaries so that all
currently visible objects just fit in the Graphics Window.
* Visibility

» "% Hide — A set of selected objects can be hidden by selecting the Hide command in the Display menu.
Hidden objects cannot be selected. The Frame Image command only frames the image based on the visible
objects.

» “& Show — Hidden objects can be made visible by selecting the objects and choosing the Show command in
the Display menu. This method applies to objects such as solids, TINs, and mesh layers which can be selected
with an icon. Other items such as cells and elements cannot be selected when hidden but can be made visible

by selecting the Show command with nothing selected. In this case, all hidden objects are made visible.

2 Isolate — In many cases it is useful to hide all of the current objects but one. One way to do this is to select
all of the objects to hide (without selecting the desired object) and then select the Hide command. A quicker

way to achieve the same result on one or more objects is to use the Isolate command in the Display menu. The



http://www.xmswiki.com/xms/index.php?title=GMS:Display_Options
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Isolate command makes the selected items visible and automatically makes all other items of the same type

invisible.

* View Angle

The objects in the Graphics Window can be rotated and viewed in three dimensions. Two angles, bearing and
dip, are used to rotate the view. The bearing and dip values correspond to a rotation about the z and x axes. The
bearing affects the horizontal angle (rotating the object in the xy plane), and the dip changes the vertical angle
(shifting the viewing angle on the object to a higher or lower perspective). The object cannot be tilted
sideways. Using only two viewing angles rather than three limits the viewing angles, but it is simpler and more
intuitive. The bearing and dip angles can be explicitly defined in the View Angle dialog accessed by selecting
the View Angle command from the View menu. The viewing angles can be manipulated interactively with the
Rotate tool.

¢ Window Bounds

The region of the real world coordinate system that is mapped to the Graphics Window can be altered using the
Pan and Zoom tools. It is also possible to precisely control the visible region by selecting the Set Window
Bounds command from the View menu. This command brings up the Set Window Boundaries dialog. If the X
range to be specified (preserves aspect ratio) option is selected, the x coordinate at the left and right and the
y coordinate at the bottom of the Graphics Window are specified. The y coordinate at the top of the Graphics
Window is not specified in order to maintain the aspect ratio. If the Y range to be specified (preserves aspect
ratio) option is selected, the y coordinate at the top and bottom and the x coordinate at the left of the Graphics
Window are specified. The x coordinate at the right of the Graphics Window is not specified in order to
maintain the aspect ratio. If the X and Y range to be specified (alters aspect ratio) option is selected, the x
coordinate at the right and left and y coordinate at the top and bottom of the Graphics Window are specified.

Since all four coordinates are specified, the aspect ratio of the scene may be altered.

¢ Views

{7 Plan View — Changes the viewing angle so that the user is looking down the z-axis with the x-axis
horizontal and the y-axis vertical.

i@ Front View — Changes the viewing angle so that the user is looking down the y-axis with the x-axis
horizontal and the z-axis vertical.

(i) Side View — Changes the viewing angle so that the user is looking down the x-axis with the y-axis
horizontal and the z-axis vertical.

¢ Oblique View — Changes the viewing angle so that the user is looking at the model at an angle of 45° to
each axis.

Previous — Restores the Graphics Window viewing parameters as they were before the last viewing command
was issued (rotate, zoom, pan, etc.). Views are automatically saved in a list so continued use of this command

will continue to restore previous views.

¢ General/Ortho Mode

A command is provided in the Display menu for switching between the orthogonal and general viewing

modes. The orthogonal mode is only available with 3D grids.

¢ Convert To Cad

Converts any visible geometric data into CAD format internally within GMS. This CAD data will be
saved with the project as a DWG file, or can be exported as a separate DWG or DXF file. This
command is found either in the the Display menu or by right-clicking in the empty space in the Project

Explorer.

¢ Toolbars

The Toolbars menu allows the user to hide and show the listed toolbars.
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* Plot Wizard

Brings up the Plot Wizard dialog.
* Animate

The Animate command launches the Animation Wizard.
* Play Animation

The Play Animation command launches an *.avi player that allows the user to browse for an *.avi file

and play the animation.

Contour Options

The options used to generate contours can be edited by selecting the Contour Options command in the Display

menu. The items in the Contour Options dialog are as follows:

General vs. Grid Layers

There are two tabs associated with the Contour Options dialog. The options described below are for the General
options. The Grid Layers options are used when contouring 3D grids.

Contour Method

There are 3 main types of contours: linear, color filled, and both linear and color filled.

Linear — The default method is Normal linear contours and causes the contours to be displayed as piece-wise linear

strings.

Color Fill — If the Color fill between contours option is selected, the region between adjacent contour lines is filled
with a solid color. There is also a smooth option available. When this option is turned on the color between contour

lines varies according to the color ramp. The transparency of the filled contours can also be adjusted.
Linear and Color Fill — This option shows linear contours on top of color filled contours.

Block Fill - This option applies only to cell centered grids. Cells are filled with a single color. The color chosen

corresponds to the color ramp value associated with the value at the cell center.

Line options
Bold contours — The Bold every... option can be used to display contours at selected intervals with a thicker line

width.

Contour labels — The Label every... option can be used to plot labels on contours at selected intervals. The contour

label options are edited using the Contour Labels dialog.

Data Range

The values shown in the Data range section correspond to the maximum and minimum values in the active dataset.

These values are sometimes useful when choosing an appropriate contour interval.

Use each timestep's max and min — This option is only applicable is your contours are colored according to a color
ramp, and your dataset has more than one time step. If this option is on, the maximum and minimum color ramp
colors will be displayed for every timestep. Otherwise, the maximum and minimum colors apply to the entire dataset

and therefore will only appear when the current dataset contains the dataset maximum or minimum value.

Contour Specified Range — Regardless of which option is selected for the contour interval, a maximum and a

minimum contour value can be specified and the contouring can be restricted to the specified range. If desired, the
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fill below or fill above options can be turned on to color fill above/below the specified range.

Contour Interval

The contour interval defines the values

associated with the contours. Based on the BTEX : 728.000
option selected, the contour values are .mDE|
computed and displayed in the spreadsheet.
The colors of the contours will also be '
displayed if a Color Ramp is being used.

=10

Four options are provided for defining contour

intervals in the Contour Options dialog. The

options are as follows:

Number of Contours — With the Number of

Contours option, an integer is entered o1

representing the total number of contours. The
contour interval is adjusted based on the
current active dataset so that the contours are
evenly spaced and the number of contours

correspond exactly to the specified value.

Specified Interval — With the Specified
Interval option, the contour interval (5, 10, 20,

etc.) is entered directly by the user.

Specified Values — The Specified Values
option allows the user to enter a list specific

contour values. Contours are only generated at

these values.

Log Interval — When contouring chemical data, it is common to have a small "hot spot" somewhere in the interior
of the grid where the concentrations are several orders of magnitude higher than the rest of the grid. In such cases,
the contours are all biased to the high concentration zones and no contours are drawn in the low concentration zones.
A common approach for dealing with such situations is to select a set of contour values corresponding to multiples of
ten (0.01, 0.1, 1.0 10.0, etc.). This can be accomplished by explicitly assigning a set of contour intervals using the
Specified Values option. The problem with this approach is that the colors assigned to the contours are still based on

a linear interpolation of the data values, thus skewing the colors to the higher concentration zones.

If the Log Interval option is selected, GMS automatically assigns contour intervals as multiples of 10. Furthermore,
if the color-fill or color ramp option is being used, the colors assigned to the contours are distributed in a logarithmic
fashion, rather than linearly interpolated from the low to high values. A sample plot using logarithmic contour

intervals is shown below:

If the Log interval option is selected, all contour intervals will be positive. No contours are drawn in areas where the
data values are zero or negative. Furthermore, a "Starting value" must be entered. This value represents the minimum

contour value.



http://www.xmswiki.com/xms/index.php?title=File%3ALogcont.jpg
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Contour Labels

The Label Options button in the Contour Options dialog is used to access the Contour Label Options dialog. This
dialog is used to set the label color, the number of decimal places used to plot the label, and the spacing used when
the labels are generated automatically. The default spacing value controls the placement of labels when labels are

generated automatically.
Labels can be added to contours in one of two ways:

1. If the contour label option is selected in the Contour Options dialog, labels are automatically placed on the
contours. The spacing of the labels is controlled with the Contour Labels dialog.

2. In some modules, contour labels can be added manually to contours by selecting the Contour Labels tool in the
Tool Palette and clicking on the contours where labels are desired. By default, the dataset value corresponding to
the point that was clicked is computed and a label corresponding to the nearest contour value is drawn centered at
the point that was clicked. An option can be set in the Contour Label Options dialog to use the exact value at the
point that is clicked as opposed to using the nearest contour value. This option is useful to post dataset value

labels in regions where there are no contours.

r v Specified Dataset
Contour Label Opticns &J p

Settings

. The user specifies the dataset with the
Formatting

] Automatic [zbels Select Dataset... button in the Display

Font:  AaBhic |~

[] Usge scientific notation

1

Color 1

7 Use contour colar Automatically determine label zpacing

@) Usze font colar 10

Orientation

() Horizontal arientation

@ Parallel to contour

Help... (] ] | Cancel

Example of the Contour Label Options dialog.

Options | 3D Grid dialog. This brings
up a new window where the specified
dataset is selected. The contour options
available for the specified dataset are
the same as the active dataset options,
yet each must be establish separately.
This option is useful in comparing

datasets.

Grid Layer Contour
Options

When contouring 3D grid data, there

are additional options available in the

Contour Options dialog. These options let you chose the data that you want contoured. The default array used to fill

cells is the active dataset. Another option for filling cells is the data colors option; this uses an input array from
MODFLOW, MODPATH, MT3DMS, SEAM3D, or RT3D. Any of the input arrays from the models such as Kh,
Kv, Recharge, etc. can be displayed, for any stress period. For MT3DMS/RT3D/SEAM3D, you can also specify the

species.

Interpolation

GMS interpolates data from the cell centers (for cell-centered grids) to the cell corners and midsides so that the grid

can be triangulated and contoured. By default, GMS uses a fast algorithm for interpolating the data that is adequate

for the majority of situations. If the Auto-interpolate contours option is turned off, however, you can specify your

own interpolation scheme. By default, GMS truncates the interpolated values to the max and min of the data, but you

can turn that option off.
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One of the most powerful visualization .

. . . . . . Animation Wizard - Options
tools in GMS is animation. Animations E

can be created with transient or steady [¥]AVifile: [ |C:\Users\creer\Documents\GMS 9.1'gms.avi

state data. The view angle and zoom FlkMZfe: 5

factor can be changed during the O Pescpien

animation as well. Animations are Transient Maove the mouse over an option for a description.
Data set

saved in the Windows (*.avi) format.
AVI files can be played back

Particle tracking

Steady state
externally to GMS using a variety of Cross-sections / lso-surfaces
. . . . Codec: | Microsoft Video 1
applications and can be inserted into
multi-media documents and g Video Qualty. 0.75

applications. Frames persecond: 10

A new animation can be created by (Cant do transient and steady state animation at the same time.)

selecting the Animate command from (Cant do KMZ with steady state or moving view.)

the Display menu.

| <Back [ MNew>

Example of the Animation Wizard — Options dialog.

Animation Options .

There are 4 options available when

creating an animation:

Option Type
Dataset Transient
Particle Tracking Transient

Cross-sections / Iso-surfaces | Steady State

Moving View N/A

Transient vs. Steady State Animation

All of the options except Moving view are either considered Transient or Steady state. GMS does not allow use of a
Transient option and a Steady State option at the same time. Moving view, however, can be used by itself or in

conjunction with any combination of the other options.

The typical case for choosing to do a transient animation is when a projects has a transient solution generated by a
model. The transient animation could illustrate how vectors, contours, fringes or iso-surfaces change at different
solution times. A transient animation can also be used to show particle tracking over time, even with a steady state
solution.

Steady state animation can only be performed using 3D grids or 3D meshes. A steady state animation can be used
with a steady state dataset, or with one time step of a transient dataset. Two options are available for steady state

animation: Cross-section / Iso-surface animation and Flow trace animation.
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Dataset Animation

Transient dataset animation can be used with any object with a transient dataset. As each frame is generated, a set of
values corresponding to the current time is loaded into memory and the image is redrawn using the current display
options. Thus, if the contour display option is selected, the contours will vary from frame to frame according to the

changes in the dataset.

The total number of frames generated in the animation can be defined by either matching the time steps (one frame
per time step) or by using a constant interval (e.g., one frame for every two hour interval). If the Match time steps
option is chosen, extra frames can be created between each time step if necessary using linear interpolation of the

data values at the specified time steps.

Particle Tracking Animation

Particle tracking can be animated to show how pathlines grow over time. Although it is considered a Transient
option in the table above, this option can be used with a transient or a steady state solution. Only the forward

tracking particle sets can be animated.

If Particle tracking is selected by itself, the user can choose how many frames are wanted in the animation. GMS will
then compute the time at which to generate each frame by dividing the total animation time evenly by the number of
frames. The animation begins at the minimum start time of all forward tracking particle sets, and ends at the

maximum travel time of all particles (in all forward tracking particle sets).

Cross-section / Iso-surface Animation

If the Geometric surface animation option is chosen, a cutting plane and/or an iso-surface can be animated. If the
Animate cutting plane over specified XYZ range option is chosen, an x, y, and/or z cutting plane is incrementally
moved through the mesh or grid from the specified beginning location to the ending location as each frame is
generated. This generates an animation showing a moving cross section. If the Animate iso-surface option is chosen,
a single iso-value is incrementally varied between the specified beginning and ending values and a different

iso-surface is generated for each frame based on the value.

Moving View

The Moving View option can be used by itself or in conjunction with any combination of the other options. This
option can be used to change how the user views the data as the animation proceeds. The user can define views and
associate them with particular frames of the animation. When the animation is generated, GMS will interpolate

between the defined views to determine what the view should be at every frame.

Flow Trace Animation

If the Animate flow trace option is chosen, a flow trace animation of the steady state vector data on 3D grid or 3D
mesh cross sections is generated. Flow trace animation is a special type of animation that is similar to particle
tracking. A series of particles is randomly generated on the cross sections and it is traced through time. Each particle
has a limited life span. As a result, the particles appear as a series of streaks. Flow trace animation can result in

highly intuitive images of a vector field.

If there is no vector dataset or cross section associated with the current 3D grid or 3D mesh, the Animate flow trace
option and Flow trace options button are dimmed. The Animate flow trace option is also dimmed if the Flow trace
option is not selected in the Cross Section Options dialog. If the active vector dataset is transient, only the current

time step is used to generate the flow trace animation.
The Avg. number of particles per triangle edit field specifies the density of particles to be generated in the animation.
The Decay ratio specifies the amount of time necessary for a particle path to decay as it passes points in the cross

section. The Velocity magnitude limit and Velocity direction limit specify the distance that a particle will travel
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between consecutive frames.

CODEC

Starting in GMS 6.5 a user can choose what codec to use to create your AVI movie. GMS will search your computer

for all compatible codecs and they will be available in the pull down menu.

Animation Playback

Once a new animation has been generated, GMS launches the AVI player and plays the animation. The speed of

playback can be adjusted using the Speed scroll bar. The maximum speed depends on the speed of the computer and

the size of the image being animated. The smaller the image, the faster the maximum playback speed.

Color Ramp

Several of the display options (contours,
iso-surfaces, color-shaded vectors, etc.)
use a color ramp to vary the display
color based on a relative value. The
color ramp can be edited by selecting
the Color Ramp command in the
Contour Options dialog. The Color
Options dialog contains the following

options:

Legend

If the Legend option is selected, a
vertical strip of colors with a legend of
corresponding  dataset  values s
displayed in the upper left corner of the
Graphics Window whenever the color
ramp is used to display an object
(shading, color contours, etc.). The
length and width of the color legend are
specified with the Legend width and
Legend height edit fields. The values
entered for legend width and height are

in screen pixels.

Palette Method

-

Color Cptions

Palette method

() Solid color

) Intensity rmmp

|

Cument palette:
0.0

User defined palettes

7200

A
Min value: 2400

Max value: 0.0

Palette preview:

Min

Help...

Ma

OK

][ Cancel ]'

An example of the Color Options dialog.

The Palette Method section lists the three basic options for defining the color ramp:

Intensity Ramp

The Intensity Ramp option defines a ramp of colors corresponding to a varying intensities of a single color.

Hue Ramp
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The Hue Ramp option defines a ramp of color hues (red-yellow-green-blue-magenta) at the maximum color
intensity.
User-Defined

If the User-Defined option is selected, a user-defined color palette is used to define the color ramp.

User-Defined Palettes

The user-defined color palettes are listed in the upper g -
right corner of the Color Ramp Options dialog. A new New Palette Iﬁ
palette is created by selecting the New button. This button Initial Color Ramp

brings up the New Palette dialog listing a set of options [|men5h, Ramp ,]
for defining the initial color palette. These colors can be

edited using the Current Palette section of the Color o EIL' s Eotaes 1 10

Ramp Options dialog. An existing palette can be deleted Palette name;  Palette

using the Delete button. |
Once a set of user-defined color palettes are created, they

are saved with the project to a palette file (*.pal). The 1 Help... | oK { I Cancel |
Import and Export buttons can be used to share I

user-defined palettes between projects. An example of the New Palatte dialog.

Current Palette

The current color palette is displayed in the Current Palette section. The min and max value of the color ramp can be
set by clicking and dragging the two triangles just below the color palette. For user-defined color palettes, new colors
can be added, colors can be deleted, and the color associated with a color entry can be edited using the tools just

below the palette.

The data value associated with a selected color can be edited either by dragging the color or by entering a new value
directly. The values can be displayed as either percentages or direct values (corresponding to the active dataset). The

Edit Table button can be used to edit the colors and corresponding values directly in a tabular format.

Preview

The Preview section at the bottom of the Color Options dialog displays the color ramp defined by the current palette
and max and min values. The Reverse button can be used to reverse the direction of the color ramp (for example, to

switch from red-yellow-green-blue to blue-green-yellow-red).
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3.3.1. Display Options

Display Options

Most of the data types in GMS have a set of display options that can be modified using the Display Options
command in the Display menu. The Display Options command brings up the Display Options dialog. The dialog
can also be brought up using the & Display Options macro.

Data Type Tabs

The Display Options dialog contains a list of the data objects currently in memory. Corresponding data tabs are
displayed in the dialog depending on what object type is selected in the list box. Each display feature associated with
a data type is listed in the Display Options dialog. The check box next to the feature named can be toggled on or off
to control whether or not the feature is to be displayed. In addition, the button next to the feature brings up a dialog
that can be used to edit the display attributes of the feature (color, font, line thickness, etc.). The following table
describes the display options tabs that exist for the various data types. Click on the links to learn more about the

specific display options for each data type.

Image Data Type Tabs Also Available for Data Type

@ TIN Data

Borehole Data

Solid Data

2D Mesh Data | SEEP2D

2D Grid Data

2D Scatter Data

3D Mesh Data | FEMWATER, Particles, WASH123D, ADH

3D Grid Data | MODFLOW, Particles, MT3D

3D Scatter Data

Map Data MODAEM, UTEXAS

Ugrid Data

GIS Data

Cross Sections

Materials

DO+« &l d

Lighting Options

Axes

2

Drawing Grid
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General Display Options

The Display Options dialog also controls several general display options in GMS. These general display options are
described in the table below.

Display Description
Option
Z Occasionally an object may be very long and wide with respect to its overall depth (z dimension). In such cases, it is possible to
magnification | exaggerate the z scale so that the variation in the z value is more apparent by changing the magnification factor from the default
value of 1.0.
Background The Color dialog can be brought up to change the selected color. The selected color is displayed as the background color in the
color Graphics Window.
Triad options | To aide in visualization of 3D objects in oblique view, a XYZ triad can be displayed in the lower left corner of the Graphics
Window. The display, size, and color of the triad can be specified in the Display Options dialog. The triad is useful in visualizing
how the geometry currently defined in GMS aligns with the world coordinate system.

Drawing Grid Options

When entering new nodes or entering a polygon or polyline in plan view, it is often useful to have the coordinates

snap to a

uniform grid. This allows accurate placement of the objects when the desired coordinates are even

multiples of some number. The properties of the drawing grid can be controlled through the Drawing Grid HE tab of

the Display Options dialog. This dialog is accessed from the Display menu or the & Display Options macro. The

following table describes the display options available for the Drawing Grid.

Display Description
Option
Spacing The Spacing edit field specifies the spacing of the grid nodes and grid lines in the drawing grid. The Grid color window specifies the
color that is used to display the drawing grid in the Graphics Window.
Snap If the Snap option is selected, all new vertices, nodes, points, etc., snap to the closest grid point as they are being created or when they
are dragged interactively.
Display If the Display grid lines option is selected, grid lines are displayed according to the Line spacing increment. For example, if the Grid
grid lines spacing is set to 10 and the Line spacing increment is set to 5, a grid line will be drawn every 50 units. The grid line color can also be
adjusted using the button next to the Display grid lines toggle.
Display If the Display grid points option is selected, grid points are displayed according to the Grid point spacing increment. The grid point
grid points | color can also be adjusted using the button next to the Display grid points toggle.
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wma Related Topics

@ Display Options

(1] 20 Scatter Data Drawing Grid |

@ 20 Grd Data * Display Options
@ GIs Data Spacing: 0.01

]
o .

ata

B Vaterils [] Display grid lines |

& Lighting Options Line spacing increment: 5
¥, Axes e )
5% Drawing Gid [ Display grid points: -

Paint spacing incremert: 1

Z magnification: 5.0

Background color: |-
[#] Display triad [ | 'J

Triad size: 50

.

The Display Options dialog showing the Drawing Grid tab.

Vectors

If the Vectors item in the Display -
. . . . Vector Options @
Options dialog is selected for an object
TIN, Grid, or Mesh), vector plots can
( ’ ’ ] ): ) P [¥] Auto-compute length
be generated using the active vector () Lengtt i copeatist- |50
. . S
dataset for the object. One vector is b) Head width (al: 150 i|.—.|E
T
placed at each node, cell, or vertex. (6) Head length (%) 200 d L_J'.;
The display of vectors can be {d) Stem width (%a): 20
controlled using the Vector Options
dialog accessed through the Vector [ Vary length {a) according to magnitude [7] Use each timestep’s max and min
Options command in the Data menu Auto-compute scaling ratio Color speciiied range
or from a button in the Display Options Sealing ratio: | 1.0 Min magritude: | 0.0
dialog. The dialog OptiOHS are as [ Vary color according to magnitude Max magnitude: | 1.0
follows: || Display every |3 | rd vector
. . Help... [ oK {| Cancel
Dimensions |
The Auto compute length toggle is on The Vector Options dialog.

then GMS will compute the length of
the vectors. If this toggle is off then the Length can be edited. The edit fields labeled Length, Head width, Head
length, and Stem width control the size and shape of the vectors. The Head width, Head length, and Stem width are

expressed as a percentage of the Length of the vector.
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Vary Length and/or Color

Often it is desirable to vary the display of the vectors according to the magnitude of the vector function at a current
point. This can be done with the Vary length according to magnitude and Vary color according to magnitude. If the
Vary length according to magnitude option is selected each vector is displayed with a length equal to the magnitude
of the vector multiplied by the Scaling ratio. If the Vary color according to magnitude option is selected, the vectors
with the smallest and largest magnitude are draw in the color of the lowest and highest colors on the current color

ramp. All other vectors are drawn in a color which corresponds to its magnitude from the current color ramp.

Display Every Nth Vector

If the Display every _nth vector is selected, only every nth vector is drawn. This is useful when the model is so large

that drawing every vector clutters the display.

Color Specified Range

It is possible to have the current color ramp vary over a specified range of the active vector dataset. This is done by

selecting the Color specified range option and editing the Min magnitude and Max magnitude edit fields.

2D vs. 3D Vectors

If you are in one of the orthogonal views (xy plane, xz plane, yz plane) the vectors will be displayed as 2D vectors. If

you are in oblique view then the vectors are displayed a 3D vectors.

Lighting Options

This dialog allows the user to control the shading of faces in the SMS display. By default, all objects are displayed in
the color specified by their attributes. However, objects such as elements, cells and triangles which cover an area,
can be more intuitively understood if they are shaded as a three dimensional entity. The shading options includes two

toggles, one slide bar and a light position window.

The lighting options are accessed by clicking on the Lighting Options item or tab in the Display Options dialog. The
default options vary between applications, and the options may be changed, saved, and restored within the project.

Toggles

The first toggle allows the user to turn on the use of a light source. When this toggle is selected, the second toggle
becomes available. The second toggle tells SMS to smooth corners between adjacent faces. This allows the faceted

surface to appear as a smooth surface.

Slider

The slide bar allows the user to specify the amount of ambient light. Ambient light is the minimum intensity
(brightness) to be displayed. A recommended value is between 0.2 and 0.4.
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Light Position

The right side of the dialog allows the user to set the light direction and gives a preview of that direction displayed

on a sphere.

¥ Enable lights Flan view. Drag to direct selected light.

Default
Scheme 2

— Suface attributes for all lights
IV Smooth edges Shirry:

— Intensity for selected light
Ambient: Diffuse: Specular:

_J—

|

Light | Enable | X ¥ Z Ambient Diffuse Specular |~
1 W~ 0806 |00 200 1000  |990 -
2 [ |05 |D0439 0542  [580 1000 |100.0

3 0 oo |00 |10 0.0 40.0 a0 |=|

The following table describes the lighting display options.

Display Option

Description

Enable lights

This check box controls whether light sources are used in the lighting process for generating lighted images. These light sources
control the intensity of the colors on the lighted image and highlight the relief or geometrical variation in the surface of the
objects being lighted.

Lighting list box

This list contains preset lighting schemes and highlights the scheme currently displayed.

Renaming a

Double click on a scheme to begin editing its name.

scheme

Deleting a Right click on a scheme and select Delete. The final scheme cannot be deleted.

scheme

Creating a Right click on a scheme and select duplicate.

scheme

Plan view This preview shows the current light scheme on a sphere in plan view, i.e., looking along the z-axis. Click or drag within the
preview preview to direct both the diffuse and the specular components of the light currently selected in the light table. The selected

light direction is shown by a dot on the sphere. A direction from in front of the sphere is shown by a green dot, and from in back
by ared dot.

Smooth edges

Check this box to smooth all diffuse and specular lights of this scheme so that the surface does not appear faceted.

Shiny

Increase this value to sharpen all specular highlights of this scheme. At 100% this value turns off the specular highlight since it
assumes that all specular lights are points whose reflection shrinks to a imperceptible point at maximum shinyness. At 0% this
value assumes that the full intensity of the light is reflected in all directions (decrease the specular values proportionally to get a
realistic effect of less and less light reflecting to the eye from each surface).

Ambient slider

Shows the Ambient value of the light currently selected in the table, and can change the value. The ambient value is light from
all directions which lights each and all surfaces uniformly leaving no surface unlighted. It is most useful on surfaces facing
away from directional light such as diffuse and specular light.
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Diffuse slider Shows the Diffuse value of the light currently selected in the table, and can change the value. The diffuse value is for a point
light which brightens surfaces in all directions the more they face the that light, and which leaves surfaces in darkness that face

away from the light.

Specular slider Shows the Specular value of the light currently selected in the table, and can change the value. The specular value is a point
light which brightens surfaces if they reflect like a mirror from the direction of the light to the direction of the viewer, and
which leaves surfaces in darkness that do not have this angle of reflection.

Light table Displays the enable, xyz position, Ambient, Diffuse, and Specular values for each of 8 lights in the current scheme, and
highlights the currently selected light. Any of these values may be modified by clicking them and editing their value.

Enable column Check these boxes to turn on each light.

X,Y,and Z Edit these values or click/drag in the plan view preview sphere to change the direction of the light. These values are will be

columns normalized to a unit direction vector.

Ambient, Diffuse, | Edit these values or drag their corresponding slider.
and Specular

columns

Plot Axes

Version 9.2 and earlier

The Plot Axes are a set of ruled lines 3
@ Display Options [
oriented in either the world coordinate :
] 2D Scatter Data Plot Axes |
system or the grid coordinate system. %é?fg;:“ (] Display plot aves Rt dccanzzisigedt
. " Map D: Qrigin
The axes can be either 2D or 3D. The %TIZPD;: & Use word cosrdinte arin
. FH# Materizls (0 Use 30 grid origi
properties the plot axes can controlled & Ligring Optons b

| | Y I S

through the Plot Axes tab of the 8} Oraving G Coordinsts syem: ;
World Coordinates H
Display Options dialog. The Plot Axes Boundng volume: :

Fit to bounding velume - h

options are accessed by selecting the ;

Z magnification: 5.0

Background color: |-

[ Use exponential notation

Axes £, item in the Display Options

dialog. The Plot Axes tab is then = l_
displayed on the dialog, and is used to Tiadsize: 50 =
specify the attributes of the axes, axes S [Wm [ T Fraee)

. Xeais |Auto scdle ~ | 612277.09335... | 616267.91638. | 500.0 1
ticks, axes labels, and axes numbers. Yads |Auto scale v | 3427396.7305... | 24293017357... | 1000.0 1

The following table describes the EoEEr e 108 1

Ll m b

1

display options available for the plot

axes.

The Display Options dialog showing the Plot Axes tab in GMS 9.2 and earlier.
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exponential

notation

Display Description
Option
Display plot | If the Display plot axes toggle is selected, the plot axes will be displayed as specified and a sample of the plot axes will appear in
axes the window in the upper left of the dialog. If the Display plot axes toggle is not selected, all plot axes will be hidden and the rest of
the dialog will be dimmed.
Origin If the Use world coordinate origin option is selected, the numbers displayed on the plot axes are defined by the origin of the world
options coordinate system. If there is either a 2D or 3D grid currently defined in GMS, the origin of the grid can be used to define the
numbering by selecting either the Use 3D grid origin option or the Use 2D grid origin option. If there is not a 3D grid defined in
GMS, the Use 3D grid origin option is dimmed. Likewise, if there is not a 2D grid defined in GMS, the Use 2D grid origin option is
dimmed.
If the world coordinate origin is used, the world coordinate system will also be used to align the axes. However, if the origin of
either the currently defined 2D or 3D grid is used, the plot axes can be aligned with either the world coordinate system or the local
grid coordinate system. If the angle of rotation of the currently defined grid is 0.00 degrees, there is no difference between the world
coordinate system and the local grid coordinate system. If there is an angle of rotation other than 0.00 degrees, the local grid
coordinate system can be used by selecting the Local grid coordinates option. The world coordinate system can be used by selecting
the World coordinates option.
Use This option controls whether or not the axes numbers are displayed using exponential notation.

AXxis extents

The extents of the plot axes are specified with the controls in the spreadsheet. The Auto scale X, Auto scale Y, and Auto scale Z
options are used to specify that the extents and spacing of the axes will be automatically calculated by GMS. If extents or spacing
other than the calculated defaults are desired, any or all of the Manual scale X, Manual scale Y, and Manual scale Z options can
be selected. If one of the Manual scale options is chosen, the min, max, tick interval, and how many ticks are to be labeled are
specified for the corresponding direction.

All of the directions that use the Auto scale option are further controlled by the Fit to bounding volume and the Offset from
bounding volume options. If the Fit to bounding volume option is selected, the axes will be placed such that they fit tightly to the
bounding volume of the currently defined objects in GMS. If the Offset from bounding volume option is chosen, the axes will be

placed such that they are 15-20% larger than the bounding volume of the currently defined object in GMS.

Axis

properties

The axis properties can be changed for each axis by right-clicking no the axis in the canvas window. The right-click menu options
include Hide axis and Edit Axis. The Edit Axis options brings up a separate dialog with attributes including color and size that can be

specified.
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Version 10.0

The Plot Axes are a set of ruled lines
oriented in the world coordinate
system. The plot axes options can be
controlled through the Plot Axes tab of
the Display Options dialog. The
following table describes the plot axes
options.

Z magnffication: 1.0

Background color: ] 'I
Display triad [ | 'I
Triadsize: 50

Help...

@ Display Options. g

B 20 Grid Data Aoces? |

E 2D Scatter Data

E8 30 Grid Data [@iEnable axes

@ 3D Scatter Data Fl mode:

S

& UGnd Data Tick location:

Bl Matenials

I Lighting Options Grid line locatiorn:

B mees

H Drawing Grid Aris | Title | Labels | Ticks| MinorTicks ‘ GridLines | Color
) N 0 N s
K | W VW ~ i
Yo |Yais W ¥ ird _t
z Z-avis = I 3 | I

Cancel

The Display Options dialog showing the Plot Axes tab in GMS 10.0 and later.

Display Option

Description

Enable axes

If on, the axes will be displayed.

Fly mode These options control where the axes are placed.

Tick location

Controls whether tick lines placed along the axes are drawn inside or outside.

Grid line location | These options control which surfaces grid lines are placed on.

XYZ Options

For each axis, several options are available.
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3.4. Other Tools

Annotations

Annotation Objects

The XMS application family provides a series of tools to annotate the data in an application for presentations,

animations and screen shots.
These tools (annotation objects)are accessed through the Annotations Module and include:

* Images

* North Arrows
e Scale Bars

e Text

e Lines

e Ovals

* Rectangles

Screen vs World Space Layers

All annotation layers either contain objects referenced to world or screen coordinates. Objects referenced to world
coordinates will change size and position on the screen with the underlying data. This is useful to identify specific
locations in your model such as peir locations. Objects associated with screen coordinates do not move on the screen
with the underlying data. This is useful for titles, legends such as north arrows and scale bars, and logos. Some types
of annotations can only be created in screen space layers including North Arrows, Images, and scale bars.

If the first annotation object you create, could be part of a screen or world space layer SMS will ask which type of
layer you wish to create and add the object to. You can create additional layers by right clicking on the Annotation
Data tree item and selecting Create Screen Space Layer or Create World Space Layer. Layers are differentiated by

including an 'S’ for screen space layers or "W' for world space layers in their icons in the project explorer.
If multiple layers exist, any newly created annotation object will be placed in the "current" layer.

&-CJ0@ Annctation Data
[0y Screen Layer
D% World Layer
..y My Layer

Annotation Object Attributes

The extents of annotation objects defined by a frame. The user defines this frame initially when creating the
annotation object by left clicking at any point on the screen and dragging a rectangle with the mouse (left button still
down). The display will show the frame while you drag with the mouse. (Points and lines defining degenerate frames
are not allowed.) When the user creates a annotation, if the frame is too big for the window, it will be resized
appropriately. Annotations can't be resized or moved even partially outside of the borders of the window. If the user
resizes a annotation through a quick mouse drag and the cursor lands outside the window, the annotation will be

redrawn to take up all the window space in that direction.
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This frame bounds the region of the screen where the object will appear with the modeling data. The user interacts
with the object by interacting with its frame and specifying its attributes or properties (see the section on selection
below). The frame anchors the annotation object on the screen. This anchoring defines both the size and position of
the object. The x-location, y-location, x-size and y-size are all defined independently as either a pixel value or

percentage of the screen.

Horizontally, the user can position the left edge, the right edge or the center of the object. If the user positions the left
edge, the object position is defined relative to the left edge of the screen. If the user positions the right edge, the
object position is defined relative to the right edge of the screen. If the user positions the center of the object, the

object position is defined relative to the horizontal center of the screen.

For example, the left side of the frame may be specified as 100 pixels from the left edge of the screen. Alternatively,
the user may specify that the right edge of the frame should be 10% of screen width from the right edge. Finally, the
user may specify that the center of the object is 100 pixels to the right of the center of the screen.

The vertical position and sizes of the object are similarly specified in the anchoring attribute of the object.

All annotation objects also have attributes. The specific attributes depend on the type of object. The attributes define

color, line thickness, fill properties, associated images, etc.

Screen Space Images

A screen space image is simply a graphics icon mapped to the screen. A typical application would be to display a

company, department, or municipality logo next to the numeric model being displayed in the graphics window.
Attributes of the screen space images include:

* General anchoring attributes

* The image file being displayed as part of the project

¢ Whether the image is being displayed as a scaled (distorted object), scaled based on its original aspect ratio, or
locked at another aspect ratio.

» Transparency — The image properties dialog have a transparency checkbox. When checked it will cause the image
to be redrawn with the most used color in the image. When that it is checked, it also causes the color checkbox
and the tolerance edit field to become available. If the color checkbox is checked, it will activate the color button
and the color button will have the latest chosen image color painted on it or the most used color in the image, if it
has not been activated before. Clicking on the down arrow part of the color button causes a color popup to be
displayed with swaths of the 40 most used colors in the image or all the colors in the image, if the image has less
than 40 colors. Clicking on one of those colors will cause the image to be redrawn with that color made
transparent in the image. The tolerance edit field allows for variation in the matching of the red, green and blue
components. The tolerance field ranges in allowable values from 0.0 to 1.0. 0.0 means the red, green and blue
components must exactly match. Values higher than 0.0 indicate the degree of variation from the given color.

Clicking the transparency checkbox to the off state causes the image to be redrawn with no transparency.
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Scale Bars

A scale bar occupies a fixed size of the screen to display the relative size of the objects in the simulation. The user
defines the minimum width of the scale bar section (in pixels), along with a minimum and maximum height of the
scale (also in pixels). The XMS application adds a "Units" label (meters in the image shown below) and labels for

the model distance related to the scale divisions.

Meters
o 250 500 740
W N W E.

The XMS applications will compute a well conditioned number to use as the scale increment that fits in the specified
scale bar extents.

Attributes of the scale bar include:

* General anchoring attributes.

* The minimum spacing between distance labels.

* The minimum division width (in pixels). The XMS application determines the number of divisions based on the
minimum divisiion width and the width of the frame.

* The minimum and maximum height of the scale bar object.

* The font (style, color, size) used to label the scale bar.

¢  Whether or not the area behind the scale bar will be filled, and if so, with what color.

North Arrows
N North arrow objects consist of automatically rotating screen space images. When an XMS
application is installed, at least one default North Arrow image will be included in the application's
i home directory. Users may create or download as many north arrow icons as desired. These icons

are displayed at the specified location (anchored with the standard options), but will rotate as the
view direction changes so that the "up" direction of the icon always aligns with the "North" or

positive "Y" direction.
Attributes of north arrows include:

* See screen space image attributes.

Text

Text can be created in world or screen space layers.

You can enter text by clicking in the graphics window with the Create Text tool active.
You can set the following attributes for text:

* Font — including size

» Color

* Background — fill behind with the background color or another color

¢ Border and border thickness
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Lines/Arrows

You can create Lines/Arrows using the Create Line Tool. Lines/Arrows can be created in screen or world space
layers.

The attributes available for Lines/Arrows include:

* Type — Dashed or solid w/ thickness
* Color

* Arrowheads — location (beginning, end, both) and size

Ovals

You can create ovals by dragging a box with Create Oval tool active. Ovals can be created in world or screen space
layers.

The attributes that can be specified for ovals include:
* Line type — dashed/solid with width

e Line color
¢ Fill and color or No Fill

Rectangles

Rectangles can be created in screen or world space layers. Their attributes are the same as those available for ovals.

Selection

The first toolbar button is used to select and set attributes for annotation objects. This requires that objects exist to be
selected. In this case when you press this tool and then left click in the annotation object, the object frame will be
drawn around the annotation. In addition to the frame, the XMS application displays grab handles on the corners and
edges of the frame. The user modifies the rectangular shape of the annotation by dragging one of the grab handles

and changes the position of the object by dragging the annotation (click at any point in the object interior).

When this tool is active the right mouse button will pop up a menu of all dialogs for that particular type of

annotation. This will include at least "Attributes" which will display a dialog of the objects attributes for editing.

Viewing Annotations At Specific Time Intervals

Available in SMS 11.1 and in development for GMS, annotations can be setup to be viewed at specific time

intervals. To setup annotations so they only are displayed at specified time intervals do the following:

* Right-click on the Annotation layer in the tree then select Properties....

» This dialog will display the Annotation Layer Properties dialog.

¢ Check the Apply time range checkbox

* Modify the "begin" and "end" time controls to specify the range for when annotations are visible.
* Click Ok.

Now film loops and time steps will only display the annotation when its within the range specified.
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CAD Options

DWG and DXF files can be imported into GMS and displayed to assist in model placement or simply to enhance the

display of a model.

The objects in a DWG or DXEF file are organized into layers. The display of layers in a CAD drawing is controlled
using the check boxes in the Project Explorer. Individual layers can be turned off/on or if you would like to turn off
the display of all CAD data then uncheck the box next to the CAD folder.

Delete Data

To Delete the CAD Data right-click on the CAD data folder in the tree and select Delete from the pop-up menu. If
the CAD data was imported from a file, the file is not deleted from disk.

CAD U Feature Objects

CAD data can be converted to GMS feature objects by right-clicking on the CAD data folder in the Project Explorer
and selecting CAD To — Feature Objects command. CAD points are turned into points, CAD lines and polylines
are turned into arcs, and CAD polygons are turned into polygons. The feature objects are added to the active
coverage. Once converted, the feature objects can be used to build conceptual models.

CAD U TIN

A set of CAD 3D faces which have been imported to GMS can be converted to a TIN by right-clicking on the CAD
data folder in the Project Explorer and selecting the CAD To — TIN command.

Convert To CAD

This command converts any visible geometric data into CAD format internally within GMS. This CAD data will be
saved with the project as a DWG file, or can be exported as a separate DWG or DXF file. This command is found
either in the the Display menu or by right-clicking in the empty space in the Project Explorer.
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Cross Sections

f

Cross sections—also referred to as fence diagrams—are flat surfaces used to visualize the subsurface. GMS has
different types of cross section objects:

e Solid Cross Sections

* Borehole Cross Sections
* 3D Grid Cross Sections
* 3D Mesh Cross Sections

Solid Cross Sections

Solid cross sections can be created by "slicing" through a set of solids using the Create Cross Section tool. This can
be done at any angle and the slicing can be done using a multi-segment polyline. Solid cross sections can be
converted to a conceptual model. This is useful if there is a solid model of an embankment that the user wants to
analyze using UTEXAS.

Example of fence diagrams created using solids
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Borehole Cross Sections

Borehole cross sections are quite different than solid, 3D grid, and 3D mesh cross sections. See the page on Borehole
Cross Sections.

Borehole cross section

3D Grid Cross Sections

3D grid cross sections are created similar to solid cross sections. Data sets are automatically interpolated from the 3D

grid to the cross sections and contours can be displayed on the cross sections.

Two cross sections cut through a 3D grid
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3D Mesh Cross Sections

3D mesh cross sections are created similar to solid cross sections. Data sets are automatically interpolated from the

3D mesh to the cross sections and contours can be displayed on the cross sections.

Multi-panel cross section cut through a 3D mesh

Cross Section Options

When cross sections are created from a mesh or a grid, values of the active scalar and vector datasets are interpolated
to the cross sections. Whenever a new dataset is chosen as the active dataset for the mesh, the data values are

re-interpolated to the cross sections.

The properties of all cross section data that GMS displays on the screen can be controlled through the Cross Sections
tab of the Display Options dialog. This dialog is opened by right-clicking on the Lg Cross Sections entry in the
Project Explorer and selecting the Display Options command. It can also be accessed from the from the Display

menu or the & Display Options macro. The following table describes the display options available for the cross

sections.
Display Option Description
Interior edge By default, the lines representing the intersection of the cross section with the faces of the cells or elements are displayed on the
removal cross section. These lines can be hidden by selecting the Interior edge removal option.

Cross section If this option is on, the lines that make up the cross section are displayed.

edges

Cross section If this option is on, then the cross section will be displayed as a set of filled polygons.

faces

Contours If the Contours item is selected, contours are displayed on the cross sections using the active scalar dataset.

Vectors If the Vectors item is selected, vectors are displayed on the cross sections using the active vector dataset when the cross sections
are displayed.

Flow trace If the Flow trace item is selected, a flow trace image is texture mapped to each cross section using the active vector dataset when

flow trace option is used with the Animation wizard.
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Convert Cross Section to Coverage

Cross sections can be converted to coverages by right clicking on the coverage and selecting the Convert To
Coverage command. The outer boundary of each material zone is converted into arcs and polygons are

automatically built.

/ Convert To Coverage

Hide

Isolate

Delete
i L.
3 il

Converting a cross section to a coverage. The resulting coverage from the cross section.

When this command is executed the user is prompted to select where the new coverage(s) should be created in the
project explorer. If the user wishes to have the materials from the cross section assigned to the appropriate polygons
in the coverage then the user should select an appropriate conceptual model. The conceptual model must support the
assignment of materials to polygons (MODFLOW, SEEP2D/UTEXAS, FEMWATER).

Coordinate Transformation

The coordinates of points from the cross section are transformed into the XY plane. The x coordinates are calculated
relative to zero where zero is defined as one end of the cross section. Currently the end of the cross section that is
designated as zero is the end with the minimum Y coordinate. If the cross section is horizontal then the end of the

cross section with the minimum X is used.

The x coordinates are calculated by finding the distance of the point from the end of the cross section that was set as
zero. The Y coordinates are calculated by subtracting the minimum z value of the cross section from the z value of

the point (y = z - z_min).

Limitations

* The cross section must be vertical.
* The cross section must be a single panel (when viewing the cross section in plan view it appears as a single line

segment).
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Datasets

A dataset is a set of values associated with each node, cell, vertex, or scatter point in an object. A dataset can be
steady state (one value per item) or transient (one value per item per time step). The values in the dataset can be
scalar values or vector values. Certain types of objects in GMS have an associated list of scalar datasets and a list of
vector datasets. Each of the following objects in GMS can have both scalar a vector datasets:

* TINs

* 2D Meshes

* 2D Grids

* 3D Meshes

* 3D Grids

The following objects can only have scalar datasets:

* Borehole Sample Data

e 2D Scatter Point Sets

* 3D Scatter Point Set

The commands for manipulating datasets are located in the Edit menu.

Datasets are used for both pre- and post-processing of models. For example, a scalar dataset associated with a 3D
grid can represent starting values of head or values of hydraulic conductivity for a groundwater modeling problem.
Another dataset associated with the same grid may represent computed head values. Datasets can be used to generate

contours, iso-surfaces, vector plots, and animation sequences.

Generating Datasets

Datasets can be generated in a variety of ways. They can represent output from a groundwater model (head,
drawdown, etc.). They can represent tabular values in a text file entered by the user or exported from another
application such as a GIS. They can be created by interpolating from a scatter point set to a TIN, grid, or mesh.

Datasets can also be generated by performing mathematical operations on other datasets with the Data Calculator.

One advantage of the dataset list approach for managing information is that it facilitates transfer of information
between different types of models or models with differing resolution. This is accomplished through scatter point
sets and interpolation. TINs, borehole contacts, borehole sample data, grids, and meshes can all be converted to a 2D
or 3D scatter point set. When an object is converted to a scatter point set, all scalar datasets associated with the
object are copied to the new scatter point set. The datasets can then be transferred from the scatter point set group to

other objects of any type using one of the supported interpolation schemes.

Importing/Exporting Datasets

A dataset can be exported by right-clicking on the dataset in the Project Explorer and select the Export command.

The Save As dialog has three filter types that can be exported:
* Binary Dataset Files (*.dat)

¢ ASCII Dataset Files (*.dat)

¢ HDFS5 Dataset Files (*.h5)

A dataset can be imported by right-clicking on any of the objects explained above in the Project Explorer and select

the Import Dataset command. This command brings up the File Open dialog.
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Project Explorer

Datasets are displayed and managed in the Project Explorer. Click here to learn about datasets in the Project

Explorer.

Active Dataset

Each object (TIN, Grid, Mesh, or Scatter Point Set) in GMS has a set of values which is designated as the "active
dataset." The active dataset is an important part of model visualization in GMS. Each time the display is refreshed,

the contours and other display features are generated using the active dataset.

The active dataset and time step are displayed in the Project Explorer. Left-clicking on a solution or dataset in the
Project Explorer makes that item "active" and the display is automatically updated in the GMS window. The table

below shows the icons displayed next to the active datasets.

i=i | active scalar dataset

27] | active vector dataset

4 | active ccf dataset

Dataset Info
Selecting the Properties command in .
. . . (@ Data Set Info [
right-click menu on a dataset in the
Project Explorer will bring up the Data set: Active time step histogram:
. | e
Dataset Info dialog. The components e defat =
of the dialog are as follows: MNumber of values: | 357 w2
MNumber of time steps: |1
Min data set value: | 0.0 fue
Statistics Max data set value: 0.0 fae
First time step time: 0.0 &
A set of statistics related to the active Last time step time: | 0.0 :
dataset is displayed on the left side of Use reference time: I = .
. L. Reference time: 12/3...
the Dataset Info dialog. the statistics
. Intervals: 1
for all time steps can be shown by EEE
selecting the Show all time step stats. i DIhc""" ol
toggle. A histogram of the data values Time step number: |1
Time: 0.0

is displayed on the right side.

. T . Min value: 0.0
Right-clicking on the plot and selecting T o0
the Plot Data command brings up the Range: 0.0
X-Axis Precision dialog. This dialog Mean: s

. Median: 0.0
enables users to set the precision of the Sordad denaie= oD
x-axis of the Histogram.
Help. . [ ok || Cancel

View/Edit Values Example of the Dataset Info dialog

For datasets associated with model
solutions, the data values can be displayed in a spreadsheet using the View Values button. For all other datasets, the

button label changes to Edit Values and the spreadsheet can be used to change the dataset values.
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Active/Inactive Flags

If the currently selected module is the 3D Grid module, the active/inactive status of cells can be changed by selecting

the Edit button at the bottom left of the dialog. This brings up the Active/Inactive Flags dialog.

Date/Time Display

For a transient dataset, the time values can be displayed in the Time Step Window using either a relative time format
(e.g., 100.0) or using a date/time format (e.g., 1/12/1998 3:23:48). The relative times are computed using a reference
time that is defined for the model (MODFLOW, FEMWATER etc.). The reference time represents the date/time
corresponding to t=0.

Datasets in the Project Explorer

The solutions and datasets associated with a particular object (grid, mesh, scatter point set, etc.) are managed using

the Project Explorer.

Datasets

scalar dataset | ;=] | active scalar dataset

(3] | vector dataset | 23] | active vector dataset

ccf dataset | GH | active ccf dataset

3 different types of datasets are shown in the Data Tree: scalar, vector, and cff. The icons used to identify the
datasets are shown below.

If the active dataset is transient then the time steps are displayed in the Time Step Window.

Solutions

Solutions are output from a numerical model that GMS supports. Solutions are shown in the Project Explorer as a
folder with an lock on it [ga . If a solution is transient then the time steps are displayed in the Times Step Window.
Datasets can not be moved into or out of a solution folder. Also, the solution may contain text files such as the *.out
and *.glo files produced by MODFLOW. These files can viewed by right-clicking on the item and selecting View

File from the pop-up menu, or you can double-click on the item.

Clicking on a solution or dataset makes that item "active" and the display is automatically updated in the GMS

window.

Folder

The datasets and solutions are organized by folders. The user can create new folders and move datasets, solutions,
and folders to other folders anywhere on the Project Explorer. Folders can be created by right-clicking on the certain
items in the Project Explorer and selecting New Folder in the menu. A dataset or folder can be deleted simply by
selecting the folder and selecting the Delete key or by right-clicking on the item and selecting the Delete option in
the corresponding pop-up menu. Statistics about a dataset can be viewed by right-clicking on a dataset and selecting

the Properties option from the pop-up menu.
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Data Calculator

At a glance e
Tools Data Calculator
* Performs mathematical calculations E e i
H ompare dats sets = % Mesh B :00

atial

on scalar datasets b, velccty (5% mg] 2 00nia0i0

Geometry
water Surface Elevation (53) 5. 000:50:00

e Calculations can include any T s locatn e
H Sample time steps = . ¥ location 8.0 IJlEZIlEIEI
number of scalar datasets and user o S 00100
. © " Scalor o Vector 2.0 0200:00
Supplled numbers ¢ Vector to Scalar 13.002:10:00
B Cosstal 14, 0 02:20:00
 Useful for computing derived [ [
b flieiie [~ Use al time steps
values such as Froude numbers e .
. Hiter Calculator -
e Useful for comparing scalar datasets [
The Data Calculator can be used to e =
perform mathematical operations with | J o es | s | e
Add to Expression Data Set Info... + 1fx abs trunc
datasets to create new datasets. The
. Update Available Tools Output data setname: | new data set Compute
Data Calculator is accessed by

selecting the Data  Calculator
command from the Data or Edit menu. SMS Data Calculator

The components of the Data Calculator
are as follows:

Expression Field

The most important part of the Data Calculator is the Expression field. This is where the mathematical expression is
entered. The expression should be formulated using the same rules that are used in formulating equations in a
spreadsheet. Parentheses should be used to clearly indicate the preferred order of evaluation. There is no limit on the
length of the expression. The operators in the expression should be limited to the operators shown in the middle of
the Data Calculator. The operands in the expression should consist of user-defined constants (e.g., 3.14159), or

datasets.

List of Datasets

All of the datasets associated with the active object (TIN, Grid, Mesh, or Scatter Point Set) are listed at the top of the
Data Calculator. If a transient dataset is highlighted, the time steps are listed on the right side of the Data Calculator.
When a dataset is used in an expression, the name of the dataset should NOT be used. Rather, the letter associated
with the dataset should be used. For example, if a dataset is listed as "b. headl", the dataset is referenced in the
expression simply as "b"

When a transient dataset is used in an expression, either a single time step or the entire sequence of time steps may
be used. For example, the expression "abs(d:100)" creates a single (steady state) dataset representing the absolute
value of the dataset at time = 100.0. However, the expression "abs(d:all)" creates a transient dataset representing the

absolute value of each of the time steps in the original dataset.
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Result Name

When an expression is evaluated, a new dataset is created and the name of the new dataset is designated in the Result
field.

Operators

The allowable operators are listed in the middle of the dialog. Selecting one of the operator buttons adds the selected
operator to the end of the expression. However, the operators can also be typed directly in the expression field. The

function of each of the operators is as follows:

Operator Function
B Add
. Subtract
"R Multiply
A Divide
" Left Parenthesis
") Right /Parenthesis
"log(x) " The base 10 logarithm of a dataset
"In(x) " The natural logarithm of a dataset
"xMa" (x) raised to the (a) power. (x) and (a) can be any mixture of constants and datasets
" abs(x) " The absolute value of a dataset
" sqrt(x) " The square root of a dataset
"ave(x,y) " The average of two datasets
" min(x,y) " The minimum of two datasets
" max(x,y) " The maximum of two datasets
" trunc(x,a,b) " Truncates a dataset (x) so that all values are >= a and <=b
"1(x)" The inverse of (x) - Only available in SMS

Operating With Transient Datasets
Each argument in the operators listed in the table above may be:

* A steady state (1 time step) dataset

* A specified time step of a transient dataset (i.e., x:#). In this case the # represents the index of the time step as
specified in the time step window.

* A transient time step (i.e., x:all). These operations are only valid if all arguments have matching time step values.

In this case, the result will be a new transient dataset with identical time values as the arguments.

The data calculator supports an alternate format for computing attributes of a transient dataset. This alternate format
applies to three of the operators. These operators compute a single time step (steady state) dataset representing the

spatially varied attribute operating on all the time steps.




Data Calculator

Operator Function

"ave(x:all) " | The average at each location of all time steps in the dataset

" min(x:all) " | The minimum at each location of all time steps in the dataset

" max(x:all) " | The maximum at each location of all time steps in the dataset

Compute Button

Once an expression is formulated and a name for the resulting dataset has been specified, the expression can be
evaluated by selecting the Compute button. At this point, the dataset is created and the name of the new dataset

should appear in the list of datasets.

Related Links

¢ Datasets (GMS)

¢ Datasets (SMS)

¢ Datasets (WMS)

¢ Dataset Toolbox (SMS)

Display Theme

A Display Theme is a collection of display options. The user can create a display theme by right-clicking in the blank
space of the Project Explorer and selecting the New | Display Theme menu command. This will bring up the Display
Theme Properties dialog. In this dialog the user can name the display theme, select which display options to include
in the display theme, and enter the names of items that will automatically use the display theme. For more

information on display themes see the Display Themes tutorial here.

r [ B
Display Theme Properties l&]

Digplay Theme name: Display settings to include with theme
Display (1)] General: Display options: ~ Data set rendering:
[¥] Z magnification TINs [¥] Vectars

[7] Load this theme when objects with
the following names are selected in View Boreholes [ Color ramp
the Project Explorer:

[¥] Lighting Solids [¥] Cross-sections
[#] Background color 2D Mesh [¥] Isosurfaces
Flot axes 2D Grid TIN cortours
[¥] Drawing grid 2D Scatter [¥]2D Scatter contours
[#] Triad 3D Mesh 2D Mesh cortours
[¥] Materials 3D Grid 20 Grid contours
3D Scatter [¥] 3D Scatter contours
Map 30 Mesh contours
GIS 3D Grid cortours
Delete Map contours
Help... [ ok [ Cancel

The Display Theme Properties dialog
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XY Series Editor

The XY Series Editor is a special dialog that is used to generate and edit curves defined by a list of x and y
coordinates. The curve can be created and edited by directly editing the xy coordinates using a spreadsheet list of the
coordinates. An entire list of curves can be generated and edited with the Editor and curves can be imported from
and exported to text files for future use. You can also paste your xy data directly to the spreadsheet.

The XY Series Editor is used in GMS, SMS, and WMS. It was designed to be general in nature so that it could be
used anywhere that a curve or function needs to be defined. In some cases, the x values of the curve must correspond
to a pre-defined set of values. For example, the x values may correspond to a set of time steps whose interval is
established in a separate dialog. In such cases, the x fields cannot be edited but the y values associated with the
pre-defined x values can be edited. In other cases, there is no limit on the number of x values or on the x spacing and
both the x and y values can be edited.

The XY Edit Fields

The two vertical columns of edit fields on the left side of the dialog are for direct editing of the xy series values. A

pair of application specific titles appears at the top of the columns.
The buttons below the xy edit fields are used to manipulate the values in the edit fields. The buttons are as follows:
Use dates/times

For selected situations such as entering time series data in the Map module, it is useful to enter the data
in date/time format. Checking this toggle allows the x values in your curve to be entered in date/time

format.
Import/Export Buttons

The Import and Export buttons allow the user to read in or save an xy series file.

The XY Series Plot

The window in the upper right hand corner of the XY Series Editor is used to plot the curve corresponding to the xy
values in the edit fields. As each value in the edit fields is edited, the corresponding point on the curve is adjusted

instantaneously. Plot options are accessed by right-clicking on the plot.

Related Pages
*  GMS main page
e SMS main page

e WMS main page
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File:AnimationWizard.jpg Source: http://www.xmswiki.com/xms/index.php?title=File: AnimationWizard.jpg License: unknown Contributors: Jcreer
File:ColorOptions.jpg Source: http://www.xmswiki.com/xms/index.php?title=File:ColorOptions.jpg License: unknown Contributors: Jcreer

File:NewPalette.jpg Source: http://www.xmswiki.com/xms/index.php?title=File:NewPalette.jpg License: unknown Contributors: Jcreer
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Image:dispopts.gif Source: http://www.xmswiki.com/xms/index.php?title=File:Dispopts.gif License: unknown Contributors: Jcreer, Jdhowlett

File:Icon TIN.gif Source: http://www.xmswiki.com/xms/index.php?title=File:Icon_TIN.gif License: unknown Contributors: Cballard, Jcreer

File:Icon BH.gif Source: http://www.xmswiki.com/xms/index.php?title=File:Icon_BH.gif License: unknown Contributors: Cballard, Jcreer

File:Icon Solid.gif Source: http://www.xmswiki.com/xms/index.php?title=File:Icon_Solid.gif License: unknown Contributors: Cballard, Jcreer

File:Icon 2Dmesh.gif Source: http://www.xmswiki.com/xms/index.php?title=File:Icon_2Dmesh.gif License: unknown Contributors: Cballard, Jcreer

File:Icon 2Dgrid.gif Source: http://www.xmswiki.com/xms/index.php?title=File:Icon_2Dgrid.gif License: unknown Contributors: Cballard, Jcreer

File:Icon 2Dscat.gif Source: http://www.xmswiki.com/xms/index.php?title=File:Icon_2Dscat.gif License: unknown Contributors: Cballard, Jcreer

File:Icon 3Dmesh.gif Source: http://www.xmswiki.com/xms/index.php?title=File:Icon_3Dmesh.gif License: unknown Contributors: Cballard, Jcreer

File:Icon 3Dgrid.gif Source: http://www.xmswiki.com/xms/index.php?title=File:Icon_3Dgrid.gif License: unknown Contributors: Cballard, Jcreer

File:Icon 3Dscat.gif Source: http://www.xmswiki.com/xms/index.php?title=File:Icon_3Dscat.gif License: unknown Contributors: Cballard, Jcreer

File:Icon map.gif Source: http://www.xmswiki.com/xms/index.php?title=File:Icon_map.gif License: unknown Contributors: Cballard, Jcreer

File:UGrid Icon.png Source: http://www.xmswiki.com/xms/index.php?title=File:UGrid_Icon.png License: unknown Contributors: Jcreer

File:Icon GIS.gif Source: http://www.xmswiki.com/xms/index.php?title=File:Icon_GIS.gif License: unknown Contributors: Cballard, Jcreer

File:Tool CreateCrossSection.GIF Source: http://www.xmswiki.com/xms/index.php?title=File:Tool_CreateCrossSection.GIF License: unknown Contributors: Jcreer, Jhandy
File:MaterialsDisplayOptionsIcon.png Source: http://www.xmswiki.com/xms/index.php?title=File:MaterialsDisplayOptionsIcon.png License: unknown Contributors: Jcreer
File:Axes.GIF Source: http://www.xmswiki.com/xms/index.php?title=File:Axes.GIF License: unknown Contributors: Jcreer, Jhandy

File:DrawingGrid.GIF Source: http://www.xmswiki.com/xms/index.php?title=File:DrawingGrid.GIF License: unknown Contributors: Jcreer, Jhandy
Image:DrawingGrid.GIF Source: http://www.xmswiki.com/xms/index.php?title=File:DrawingGrid.GIF License: unknown Contributors: Jcreer, Jhandy
File:DisplayDrawing.jpg Source: http://www.xmswiki.com/xms/index.php?title=File:DisplayDrawing.jpg License: unknown Contributors: Jcreer
File:VectorOptions.jpg Source: http://www.xmswiki.com/xms/index.php?title=File: VectorOptions.jpg License: unknown Contributors: Jcreer
Image:LightingDialog.jpg Source: http://www.xmswiki.com/xms/index.php?title=File:LightingDialog.jpg License: unknown Contributors: Jcreer, Ksmith
File:DisplayAxes.jpg Source: http://www.xmswiki.com/xms/index.php?title=File:DisplayAxes.jpg License: unknown Contributors: Jcreer

Image:Axes.GIF Source: http://www.xmswiki.com/xms/index.php?title=File:Axes.GIF License: unknown Contributors: Jcreer, Jhandy

File:GMS Axes Display 10.jpg Source: http://www.xmswiki.com/xms/index.php?title=File:GMS_Axes_Display_10.jpg License: unknown Contributors: Jcreer
Image:AnnotationTree.jpg Source: http://www.xmswiki.com/xms/index.php?title=File:AnnotationTree.jpg License: unknown Contributors: Djordan, Jcreer
Image:Scale.jpg Source: http://www.xmswiki.com/xms/index.php?title=File:Scale.jpg License: unknown Contributors: Jcreer, Sramiah

Image:North-arrow.jpg Source: http://www.xmswiki.com/xms/index.php?title=File:North-arrow.jpg License: unknown Contributors: Jcreer, Ksmith
Image:xsect.png Source: http://www.xmswiki.com/xms/index.php?title=File:Xsect.png License: unknown Contributors: Jcreer, Unjedai

Image:Xsect_Sample.png Source: http://www.xmswiki.com/xms/index.php?title=File:Xsect_Sample.png License: unknown Contributors: Jcreer, Unjedai
Image:Xsects_3dg.png Source: http://www.xmswiki.com/xms/index.php?title=File:Xsects_3dg.png License: unknown Contributors: Jcreer, Unjedai
Image:Xsect_3dm.png Source: http://www.xmswiki.com/xms/index.php?title=File:Xsect_3dm.png License: unknown Contributors: Jcreer, Unjedai
Image:CrossSectionFolder.GIF Source: http://www.xmswiki.com/xms/index.php?title=File:CrossSectionFolder.GIF License: unknown Contributors: Jcreer, Jhandy
image:x2cov_l.png Source: http://www.xmswiki.com/xms/index.php?title=File:X2cov_1.png License: unknown Contributors: Jcreer, Unjedai

image:x2cov_2.png Source: http://www.xmswiki.com/xms/index.php?title=File:X2cov_2.png License: unknown Contributors: Jcreer, Unjedai
Image:Tree_DataSetActive.gif Source: http://www.xmswiki.com/xms/index.php?title=File:Tree_DataSetActive.gif License: unknown Contributors: Cballard, Jcreer
Image:Tree_VectorDataSetActive.gif Source: http://www.xmswiki.com/xms/index.php?title=File: Tree_VectorDataSetActive.gif License: unknown Contributors: Cballard, Jcreer
Image:Tree_CCFDataSetActive.gif Source: http://www.xmswiki.com/xms/index.php?title=File:Tree_CCFDataSetActive.gif License: unknown Contributors: Cballard, Jcreer
File:DatasetInfo.jpg Source: http://www.xmswiki.com/xms/index.php?title=File:DatasetInfo.jpg License: unknown Contributors: Jcreer

Image:Tree_DataSet.gif Source: http://www.xmswiki.com/xms/index.php?title=File:Tree_DataSet.gif License: unknown Contributors: Cballard, Jcreer
Image:Tree_VectorDataSet.gif Source: http://www.xmswiki.com/xms/index.php?title=File:Tree_VectorDataSet.gif License: unknown Contributors: Cballard, Jcreer
Image:Tree_CCFDataSet.gif Source: http://www.xmswiki.com/xms/index.php?title=File:Tree_CCFDataSet.gif License: unknown Contributors: Cballard, Jcreer
Image:Tree_Folder_Lock.gif Source: http://www.xmswiki.com/xms/index.php?title=File: Tree_Folder_Lock.gif License: unknown Contributors: Cballard, Jcreer

I SMS_Data_Calcul .jpg Source: http://www.xmswiki.com/xms/index.php?title=File:SMS_Data_Calculator.jpg License: unknown Contributors: Jcreer, Jdhowlett

File:GMS Display Theme.jpg Source: http://www.xmswiki.com/xms/index.php?title=File:GMS_Display_Theme.jpg License: unknown Contributors: Jcreer




